Mastering AutoCAD 2008 and AutoCAD LT 2008 offers a unique blend of tutorial and reference that includes everything you need to get started and stay ahead with AutoCAD. Rather than just showing you how each command works, this book shows you AutoCAD 2008 in the context of a meaningful activity. You'll learn how to use commands while working on an actual project and progressing toward a goal. Experienced author George Omura provides a foundation on which you can build your own methods for using AutoCAD and become an AutoCAD expert. Coverage includes everything from the basics of AutoCAD to programming in AutoLISP and VBA to installing and setting up AutoCAD. Whether you're an AutoCAD newbie or AutoCAD all-star, Mastering AutoCAD 2008 and AutoCAD LT 2008 has something for you.

George Omura is a licensed architect and Autodesk Authorized Author who has more than 30 years of experience in architecture and has been using AutoCAD for more than 20 years. As a CAD specialist, he has worked on design projects ranging from resort hotels to metropolitan transit systems to the San Francisco Library project. He is the all-time bestselling AutoCAD author and was cited as favorite CAD author by members of the Autodesk User Group International (AUGI) in AUGIWorld magazine's "Best of Everything CAD" issue.
Contents

Introduction ................................................. xxvii

Part 1 • The Basics ............................................. 1

Chapter 1 • Exploring the AutoCAD and AutoCAD LT Interface ............... 3
Taking a Guided Tour ......................................... 3
The AutoCAD Window ....................................... 6
The Drop-Down Menus ...................................... 9
The Dashboard ............................................. 13
The Toolbars ............................................... 14
Working with AutoCAD ..................................... 16
Opening an Existing File ................................. 16
Getting a Closer Look .................................... 18
Saving a File as You Work ............................... 22
Making Changes ........................................... 22
Opening Multiple Files ................................... 23
Adding a Predrawn Symbol with the Tool Palette .......................... 24
The Bottom Line ........................................... 25

Chapter 2 • Creating Your First Drawing .................................. 27
Getting to Know the 2D Draw Control Panel .......................... 27
Starting Your First Drawing .................................. 28
Specifying Distances with Coordinates ............................... 32
Specifying Polar Coordinates ................................ 34
Specifying Relative Cartesian Coordinates .......................... 34
Interpreting the Cursor Modes and Understanding Prompts ............. 37
Understanding Cursor Modes ................................ 37
Choosing Command Options ................................ 38
Selecting Objects .......................................... 42
Selecting Objects in AutoCAD ................................ 42
Using Noun/Verb Selection .................................. 48
Editing with Grips .......................................... 53
Stretching Lines by Using Grips ................................ 53
Moving and Rotating with Grips ................................ 55
Using Dynamic Input ....................................... 57
Getting Help ................................................. 62
Using the InfoCenter ...................................... 62
Using Context-Sensitive Help ................................ 64
Finding Additional Sources of Help ................................ 64
Staying Informed with the Communication Center ....................... 65
Displaying Data in a Text Window ................................ 66
Displaying the Properties of an Object .............................. 67
The Bottom Line ........................................... 68
## CONTENTS

### Chapter 3 • Setting Up and Using AutoCAD's Drafting Tools ............................ 71

- Setting Up a Work Area ........................................... 71
- Specifying Units ................................................. 72
- Fine-Tuning the Measurement System .......................... 74
- Setting Up the Drawing Limits .................................. 75
- An Alternative to Limits ......................................... 77
- Understanding Scale Factors ..................................... 77
- Using Polar Tracking ............................................ 78
- Setting the Polar Tracking Angle ................................. 79
- Exploring the Drawing Process .................................. 80
- Locating an Object in Reference to Others ...................... 81
- Getting a Closer Look ........................................... 82
- Modifying an Object ............................................. 82
- Planning and Laying Out a Drawing .............................. 86
- Making a Preliminary Sketch ..................................... 87
- Using the Layout .................................................. 88
- Erasing the Layout Lines ......................................... 94
- Putting On the Finishing Touches ................................. 96
- Aligning Objects by Using Object Snap Tracking ............. 97
- Using the AutoCAD Modes as Drafting Tools ................. 102
- Using Grid Mode as a Background Grid ........................ 102
- Using the Snap Modes ........................................... 104
- The Bottom Line ................................................... 105

### Chapter 4 • Organizing Objects with Blocks and Groups ......................... 107

- Creating a Symbol .................................................. 107
- Understanding the Block Definition Dialog Box ............... 109
- Inserting a Symbol ................................................ 111
- Scaling and Rotating Blocks ...................................... 114
- Using an Existing Drawing as a Symbol ........................ 115
- Modifying a Block .................................................. 118
- Unblocking and Redefining a Block .............................. 118
- Saving a Block as a Drawing File ................................ 120
- Replacing Existing Files with Blocks ............................ 120
- Other Uses for Blocks ............................................. 122
- Understanding the Annotation Scale ............................. 122
- Grouping Objects .................................................. 125
- Grouping Objects for LT Users ................................ 127
- Modifying Members of a Group ................................ 127
- Working with the Object Grouping Dialog Box ............... 130
- Working with the LT Group Manager ........................... 132
- The Bottom Line ................................................... 133

### Chapter 5 • Keeping Track of Layers and Blocks .................................. 135

- Organizing Information with Layers ............................. 135
- Creating and Assigning Layers .................................. 136
- Working on Layers ................................................ 143
- Controlling Layer Visibility ...................................... 145
CONTENTS

Finding the Layers You Want ........................................... 147
Taming an Unwieldy List of Layers .................................... 148
Assigning Linetypes to Layers ....................................... 154
Adding a Linetype to a Drawing ...................................... 154
Controlling Lineweights .................................................. 158
Keeping Track of Blocks and Layers ................................. 158
Getting a Text File List of Layers or Blocks ......................... 159
The Bottom Line ............................................................ 160

Part 2 • Mastering Intermediate Skills .............................. 161

Chapter 6 • Editing and Reusing Data to Work Efficiently .... 163
Creating and Using Templates ......................................... 163
Creating a Template ....................................................... 164
Using a Template .......................................................... 165
Copying an Object Multiple Times .................................... 165
Making Circular Copies ................................................... 166
Making Row and Column Copies ....................................... 169
Fine-Tuning Your View .................................................. 171
Finishing the Kitchenette ............................................... 173
Developing Your Drawing ............................................... 174
Importing Settings .......................................................... 174
Using Osnap Tracking to Place Objects .............................. 176
Finding an Exact Distance along a Curve ......................... 191
Changing the Length of Objects ....................................... 192
Creating a New Drawing by Using Parts from Another Drawing 193
Eliminating Unused Blocks, Layers, Linetypes, Shapes, Styles, and More 194
The Bottom Line ............................................................ 196

Chapter 7 • Mastering Viewing Tools, Hatches, and External References 197
Assembling the Parts ....................................................... 197
Taking Control of the AutoCAD Display ............................ 200
Understanding Regeneration and Redrawing ....................... 200
Understanding the Frozen Layer Option ............................. 204
Using Hatch Patterns in Your Drawings ......................... 206
Placing a Hatch Pattern in a Specific Area ....................... 206
Positioning Hatch Patterns Accurately .............................. 208
Updating a Block from an External File ......................... 212
Changing the Hatch Area ............................................... 214
Modifying a Hatch Pattern .............................................. 214
Understanding the Boundary Hatch Options ..................... 216
Using Additional Hatch Features ...................................... 218
Using Gradient Shading .................................................. 219
Tips for Using the Boundary Hatch ................................. 221
Space Planning and Hatch Patterns ................................. 221
Using External References .............................................. 224
Attaching a Drawing as an External Reference .................. 225
Other Differences between External References and Blocks .... 227
CONTENTS

Chapter 8 • Introducing Printing, Plotting, and Layouts ......................... 239
  Plotting the Plan ................................................. 239
  Understanding the Plotter Settings .................................. 243
    Paper Size ..................................................... 243
    Drawing Orientation ........................................... 243
    Plot Area ....................................................... 244
    Plot Scale ..................................................... 245
  Shaded Viewport Options .......................................... 248
  Plot Offset ....................................................... 249
  Plot Options ..................................................... 250
  WYSIWYG Plotting Using Layout Tabs .................................. 251
  Plot Scale in the Layout Tab Viewports ................................ 253
  Adding an Output Device ........................................... 255
    Editing a Plotter Configuration .................................. 258
  Storing a Page Setup ............................................. 259
  Plotter and Printer Hardware Considerations ......................... 260
    Understanding Your Plotter's Limits ............................... 263
    Knowing Your Plotter's Origins .................................. 263
  The Bottom Line ................................................... 265

Chapter 9 • Understanding Plot Styles ............................................. 267
  Choosing between Color-Dependent and Named Plot Style Tables ............ 267
  Creating a Color Plot Style Table .................................... 269
  Editing and Using Plot Style Tables ................................... 270
  Making Your Plot Styles Visible ..................................... 272
  Making Changes to Multiple Plot Styles ................................ 273
  Setting Up Line Corner Styles ...................................... 275
  Setting Up Screen Values for Solid Areas ................................ 276
  Controlling the Visibility of Overlapping Objects ....................... 277
  Other Options in the Plot Style Table Editor ................................ 277
  Assigning Named Plot Styles Directly to Layers and Objects ............. 280
    Using Named Plot Style Tables ................................... 280
    Assigning Plot Styles to Objects ................................... 283
    Assigning Plot Style Tables to Layers ................................ 285
  The Bottom Line ................................................... 286

Chapter 10 • Adding Text to Drawings .............................................. 289
  Preparing a Drawing for Text ......................................... 289
    Organizing Text by Styles ........................................ 290
    Getting Familiar With the Text and Annotation Scale Control Panels .... 292
  Setting the Annotation Scale and Adding Text .................................. 292
    Exploring Text and Scale ........................................ 294

Other External Reference Options .......................................... 228
Clipping Xrefs and Improving Performance .................................... 230
Editing Xrefs in Place .................................................. 232
  Adding and Removing Objects from Blocks and Xrefs ...................... 234
Understanding the Reference Edit Dialog Box Options ....................... 236
The Bottom Line ...................................................... 237

Understanding Your Plotter's Origins ...................................... 263

Knowing Your Plotter's Limits ........................................... 263

Editing Xrefs in Place .................................................. 232

Adding and Removing Objects from Blocks and Xrefs ...................... 234

Understanding the Reference Edit Dialog Box Options ....................... 236
Understanding the Text Style Dialog Box Options ................................................. 295
Exploring Text Formatting in AutoCAD ................................................................. 297
   Adjusting the Text Height and Font ................................................................. 297
   Understanding the Text Formatting Toolbar .................................................... 298
   Adding Symbols and Special Characters ......................................................... 300
   Setting Indents and Tabs .................................................................................... 302
What Do the Fonts Look Like? ............................................................................. 305
Adding Simple Single-Line Text Objects .............................................................. 307
   Justifying Single-Line Text Objects .................................................................. 309
   Using Special Characters with Single-Line Text Objects ................................. 311
Using the Check Spelling Feature ........................................................................ 312
   Choosing a Dictionary ....................................................................................... 313
Substituting Fonts .................................................................................................. 314
Finding and Replacing Text ................................................................................... 316
The Bottom Line ..................................................................................................... 317

Chapter 11 • Using Fields and Tables ................................................................. 319
Using Fields to Associate Text with Drawing Properties .................................... 319
Adding Tables to Your Drawing .......................................................................... 323
   Creating a Table .................................................................................................. 323
   Adding Cell Text .................................................................................................. 324
   Adjusting Table Text Orientation and Location ................................................ 326
Editing the Table Line Work ................................................................................ 328
Adding Formulas to Cells ..................................................................................... 330
   Using Formulas Directly in Cells ...................................................................... 330
   Using Other Math Operations ............................................................................ 331
Importing and Exporting Tables .......................................................................... 332
   Exporting Tables ................................................................................................. 333
Creating Table Styles ............................................................................................ 334
   The Table Style Options .................................................................................... 335
The Bottom Line ..................................................................................................... 336

Chapter 12 • Using Dimensions ................................................................. 337
Understanding the Components of a Dimension ............................................... 337
Creating a Dimension Style .................................................................................. 338
   Setting Up the Primary Unit Style ..................................................................... 340
   Setting the Height for Dimension Text ................................................................ 341
   Setting the Location and Orientation of Dimension Text .................................. 342
   Choosing an Arrow Style and Setting the Dimension Scale ............................. 342
   Setting Up Alternate Units ............................................................................... 346
   Setting the Current Dimension Style ................................................................ 347
   Modifying a Dimension Style ............................................................................ 347
Drawing Linear Dimensions .................................................................................. 348
   Finding the Dimensions Control Panel ............................................................ 348
   Placing Horizontal and Vertical Dimensions ................................................... 349
   Continuing a Dimension ................................................................................... 350
   Drawing Dimensions from a Common Base Extension Line ............................ 351
   Adjusting the Distance between Dimensions ................................................... 353
Editing Dimensions ................................................................. 353
Appending Data to Dimension Text ....................................... 353
Using Grips to Make Minor Adjustments to Dimensions .......... 356
Changing Style Settings of Individual Dimensions ................. 357
Editing Dimensions and Other Objects Together ..................... 358
Associating Dimensions with Objects ..................................... 360
Adding a String of Dimensions with a Single Operation .......... 361
Adding or Removing the Alternate Dimensions ....................... 362
Dimensioning Non-orthogonal Objects ..................................... 363
Dimensioning Non-orthogonal Linear Distances ....................... 363
Dimensioning Radii, Diameters, and Arcs ............................... 365
Skewing Dimension Lines ....................................................... 368
Adding a Note with a Leader Arrow ....................................... 368
Creating Multileader Styles .................................................... 370
Editing Multileader Notes ....................................................... 372
Breaking a Dimension Line for a Leader ................................. 373
Applying Ordinate Dimensions ................................................. 373
Adding Tolerance Notation ..................................................... 374
Adding Inspection Dimensions ................................................ 375
The Bottom Line ................................................................. 377

Part 3 • Mastering Advanced Skills ......................................... 379

Chapter 13 • Using Attributes ............................................... 381
Creating Attributes ............................................................... 381
  Adding Attributes to Blocks ................................................. 382
  Copying and Editing Attribute Definitions ......................... 385
  Turning the Attribute Definitions into a Block ..................... 387
  Inserting Blocks Containing Attributes ............................... 388
Editing Attributes ............................................................... 391
  Editing Attribute Values One at a Time ............................... 391
  Editing Attribute Text Formats and Properties .................... 392
  Making Global Changes to Attribute Values ....................... 393
  Making Invisible Attributes Visible ................................... 394
  Making Global Format and Property Changes to Attributes ...... 395
  Redefining Blocks Containing Attributes ............................ 397
Extracting and Exporting Attribute Information ...................... 398
  Performing the Extraction ................................................... 398
  Extracting Attribute Data to an AutoCAD Table ................... 403
The Bottom Line ................................................................. 404

Chapter 14 • Copying Existing Drawings into AutoCAD ............... 405
Methods for Converting Paper Drawings to AutoCAD Files ........ 405
Importing a Raster Image ....................................................... 406
Working with a Raster Image .................................................. 409
  Scaling a Raster Image ....................................................... 409
  Controlling Object Visibility and Overlap with Raster Images ... 409
Clipping a Raster Image ................................................................. 410
Adjusting Brightness, Contrast, and Strength ................................ 411
Turning Off the Frame, Adjusting Overall Quality, and Controlling Transparency ....................................................... 413
The Bottom Line ................................................................. 415

Chapter 15 • Advanced Editing and Organizing ................................. 417
Using External References (Xrefs) .................................................. 417
Preparing Existing Drawings for Cross-Referencing ......................... 418
Assembling Xrefs to Build a Drawing ............................................ 420
Importing Named Elements from Xrefs ........................................ 425
Controlling the Xref Search Path ................................................ 426
Managing Layers ............................................................................. 427
Saving and Recalling Layer Settings ............................................. 427
Using Advanced Tools: Filter, Quick Select, and QuickCalc ................ 430
Filtering Selections ....................................................................... 430
Using Quick Select ....................................................................... 434
Using the QuickCalc Calculator ................................................... 435
Adding Foot and Inch Lengths and Finding the Sum of Angles .......... 437
Using the Display Area and Units Conversion ................................ 439
Using QuickCalc to Find Points .................................................... 441
Pasting to the Command Line ...................................................... 443
Finding Fractional Distances between Two Points ......................... 443
Using QuickCalc While in the Middle of a Command ..................... 446
Storing Expressions and Values .................................................... 447
Guidelines for Working with QuickCalc ......................................... 448
The Bottom Line ................................................................. 450

Chapter 16 • Laying Out Your Printer Output .................................... 453
Understanding Model Space and Paper Space ................................ 453
Creating a Paper Space Layout ................................................... 454
Creating New Paper Space Viewports .......................................... 455
Reaching Inside Viewports ......................................................... 457
Getting Back to Full-Screen Model Space ...................................... 459
Working with Paper Space Viewports ......................................... 459
Scaling Views in Paper Space ....................................................... 461
Setting Layers in Individual Viewports ......................................... 462
Creating and Using Multiple Paper Space Layouts ......................... 465
Creating Odd-Shaped Viewports ................................................. 466
Understanding Lineweights, Linetypes, and Dimensions in Paper Space .......................................................... 468
Controlling and Viewing Lineweights in Paper Space ..................... 468
The Lineweight Settings Dialog Box ............................................. 470
Linetype Scales and Paper Space .................................................. 470
Dimensioning in Paper Space Layouts ......................................... 471
Other Uses for Paper Space ......................................................... 473
The Bottom Line ................................................................. 474
Chapter 19 • Using Dynamic Blocks .................................................. 475
Exploring the Block Editor ............................................................. 475
   Editing a Block and Creating New Blocks ................................... 477
Creating a Dynamic Block ............................................................ 478
   Adding a Parameter ................................................................. 479
   Adding an Action ..................................................................... 480
   Adding an Increment Value ....................................................... 482
   Editing Parameters and Actions ............................................... 484
Keeping an Object Centered ......................................................... 485
Adding Scale and Stretch Actions to a Parameter ......................... 486
Adding More Than One Parameter for Multiple Grip Functions ....... 490
   Including a Mirror Capability .................................................... 490
   Adding a Selectable List ......................................................... 492
   Including Block Information with Data Extraction ..................... 494
Creating Multiple Shapes in One Block .......................................... 497
Rotating Objects in Unison ............................................................ 501
Filling in a Space Automatically with Objects ................................ 504
The Bottom Line ......................................................................... 505

Chapter 18 • Drawing Curves .......................................................... 507
Introducing Polylines .................................................................... 507
   Drawing a Polyline .................................................................. 507
   Setting Polyline Options ......................................................... 509
Editing Polylines .......................................................................... 510
   Setting Pedit Options ................................................................ 512
   Smoothing Polylines .............................................................. 513
   Editing Vertices ...................................................................... 515
Creating a Polyline Spline Curve .................................................. 522
Using True Spline Curves .............................................................. 525
   Drawing a True Spline ............................................................ 525
   Fine-Tuning Spline Curves ....................................................... 526
Marking Divisions on Curves ......................................................... 528
   Dividing Objects into Segments of Equal Length ................. 528
   Dividing Objects into Specified Lengths ............................... 530
The Bottom Line ......................................................................... 531

Chapter 19 • Getting and Exchanging Data from Drawings ............... 533
Finding the Area of Closed Boundaries ......................................... 533
   Finding the Area of an Object .................................................. 534
   Using Hatch Patterns to Find Areas ......................................... 535
   Adding and Subtracting Areas with the Area Command ........ 536
Getting General Information ......................................................... 539
   Determining the Drawing’s Status ............................................ 539
   Keeping Track of Time ............................................................ 541
Getting Information from System Variables .................................. 541
   Keeping a Log of Your Activity ................................................. 542
Capturing and Saving Text Data from the AutoCAD Text Window ... 543
   Storing Searchable Information in AutoCAD Files ................. 543
   Searching for AutoCAD Files ................................................. 544
Recovering Corrupted Files .......................................................... 545
Using the DXF File Format to Exchange CAD Data with Other Programs ........... 545
  Exporting DXF Files ............................ 546
  Opening or Importing DXF Files .......... 547
Using AutoCAD Drawings in Desktop Publishing ........................................ 548
  Exporting Raster Files ......................... 548
  Exporting Vector Files ...................... 550
Using OLE to Import Data ........................................................................... 551
  Editing OLE Links .................................. 552
  Importing Worksheets as AutoCAD Tables ................................................. 553
  Understanding Options for Embedding Data .............................................. 554
  Using the Clipboard to Export AutoCAD Drawings .................................. 555
The Bottom Line .......................................................................................... 560

Part 4 • 3D Modeling and Imaging .............................................................. 557

Chapter 20 • Creating 3D Drawings ............................................................ 559
  Getting to Know the 3D Modeling Workspace ........................................... 559
  Drawing in 3D Using Solids ...................................................................... 562
    Creating a 3D Box .................................................................................. 563
    Editing 3D Solids with Grips ................................................................. 564
    Constraining Motion with the Grip Tool ................................................. 565
    Rotating Objects in 3D Using Dynamic UCS ...................................... 566
    Drawing on a 3D Object’s Surface ....................................................... 568
    Pushing and Pulling Shapes from a Solid ............................................. 569
    Making Changes to Your Solid ............................................................. 571
  Creating 3D Forms from 2D Shapes ......................................................... 573
    Extruding a Polyline ............................................................................. 573
  Isolating Coordinates with Point Filters .................................................. 580
  Moving Around Your Model ...................................................................... 581
    Finding Isometric and Orthogonal Views ............................................ 581
    Rotating Freely Around Your Model .................................................... 582
    Changing Your View Direction ............................................................ 583
    Flying through Your View .................................................................... 584
    Changing from Perspective to Parallel Projection .................................. 585
  Getting a Visual Effect ............................................................................. 585
    Using Visual Styles .............................................................................. 586
    Creating a Sketched Look with Visual Styles ....................................... 587
  Turning a 3D View into a 2D AutoCAD Drawing ...................................... 590
The Bottom Line .......................................................................................... 593

Chapter 21 • Using Advanced 3D Features .................................................. 595
  Setting Up AutoCAD for This Chapter ..................................................... 595
  Mastering the User Coordinate System .................................................... 596
    Defining a UCS ...................................................................................... 596
    Saving a UCS ....................................................................................... 599
    Working in a UCS ................................................................................. 600
    Building 3D Parts in Separate Files ...................................................... 601
  Understanding the UCS Options ............................................................ 603
    UCS Based on Object Orientation ....................................................... 604
    UCS Based on Offset Orientation ......................................................... 606
# Part 5 • Customization and Integration

## Chapter 24 • Using the Express Tools

- Using Enhancements Straight from the Source .................................................. 743
- Opening the Express Toolbars ........................................................................... 744
- Tools for Managing Layers ................................................................................ 744
- Tools for Editing Text ......................................................................................... 746
- Express Blocks Tools ......................................................................................... 747
- Express Standard Tools ...................................................................................... 748
- Tools on the Express Drop-Down Menu ............................................................. 751
- Layout Express Tools ......................................................................................... 758
- Putting AutoLISP to Work ................................................................................ 761
- Loading and Running an AutoLISP Program .................................................... 761
- Managing Your AutoLISP and VBA Library ..................................................... 762
- Loading AutoLISP Programs Automatically ...................................................... 763
- Creating Keyboard Macros with AutoLISP ...................................................... 763
- The Bottom Line .................................................................................................. 766

## Chapter 23 • Editing and Visualizing 3D Solids

- Understanding Solid Modeling ........................................................................... 703
- Creating Solid Forms .......................................................................................... 705
- Joining Primitives ............................................................................................... 706
- Creating Complex Solids .................................................................................... 710
  - Tapering an Extrusion ....................................................................................... 710
  - Extruding on a Curved Path ............................................................................. 711
  - Revolving a Polyline ....................................................................................... 712
- Editing Solids ....................................................................................................... 714
  - Splitting a Solid into Two Pieces ....................................................................... 715
  - Rounding Corners with the Fillet Tool ............................................................. 716
  - Chamfering Corners with the Chamfer Tool .................................................... 717
  - Using the Solid-Editing Tools .......................................................................... 718
- Streamlining the 2D Drawing Process ............................................................... 726
  - Drawing Standard Top, Front, and Right-Side Views ........................................ 726
  - Adding Dimensions and Notes in a Layout ...................................................... 729
  - Using Visual Styles with a Viewport ............................................................... 730
- Visualizing Solids ............................................................................................... 731
- The Bottom Line .................................................................................................. 738

## Understanding the Rendering Options ............................................................ 682
- Checking and Saving Renderings in the Render Window ................................... 684
- Adding Cameras for Better View Control .......................................................... 684
  - Making Adjustments to Your Camera .............................................................. 687
  - Creating an Animated Walk-Through ............................................................... 690
  - Fine-Tuning the Animation ............................................................................. 691
- Printing Your Renderings .................................................................................. 693
- Simulating Natural Light .................................................................................... 694
  - Rendering Interior Views ................................................................................ 695
  - Using the Sun And Sky Simulation ................................................................ 698
- The Bottom Line .................................................................................................. 701

## Chapter 15 • Using AutoLISP Tools

- Tools for Managing Layers ................................................................................ 744
- Tools for Editing Text ........................................................................................ 746
- Express Blocks Tools ........................................................................................ 747
- Express Standard Tools ..................................................................................... 748
- Tools on the Express Drop-Down Menu ............................................................ 751
- Layout Express Tools ......................................................................................... 758
- Putting AutoLISP to Work ................................................................................ 761
- Loading and Running an AutoLISP Program .................................................... 761
- Managing Your AutoLISP and VBA Library ..................................................... 762
- Loading AutoLISP Programs Automatically ...................................................... 763
- Creating Keyboard Macros with AutoLISP ...................................................... 763
- The Bottom Line .................................................................................................. 766
**Chapter 25 • Exploring AutoLISP** ........................................... 767
  Understanding the Interpreter ............................................. 767
  Defining Variables with Setq ............................................ 768
  Understanding Data Types .................................................. 768
  Using Arguments and Functions ........................................... 770
  Using Text Variables with AutoLISP .................................... 771
  Storing Points as Variables .............................................. 772
  Creating a Simple Program ................................................ 773
  Dissecting the Rectangle Program ....................................... 774
  Selecting Objects with AutoLISP ........................................ 778
    The Ssget Function ....................................................... 779
  Controlling the Flow of an AutoLISP Program ......................... 780
    Using the If Function ................................................... 780
    Repeating an Expression ............................................... 782
    Using Other Built-in Functions ...................................... 783
  Data-Type Conversions .................................................... 785
  Storing Your Programs as Files ......................................... 786
  Getting More Help with AutoLISP ....................................... 787
    The Bottom Line .......................................................... 787

**Chapter 26 • Customizing Toolbars, Menus, Linetypes, and Hatch Patterns** ............................................. 789
  Using Workspaces .......................................................... 789
  Customizing the User Interface ......................................... 791
    Taking a Quick Customization Tour .................................. 791
    Getting the Overall View .............................................. 793
    Finding Commands in the Command List ............................. 795
    Preview/Button Image/Shortcuts ...................................... 795
    Getting to the Core of Customization in the Properties Group .. 795
    Creating Your Own Toolbars and Menus .............................. 796
    Customizing Control Panel Tools .................................... 797
  Creating Macros in Tools and Menus ................................... 800
  Pausing for User Input .................................................... 801
  Opening an Expanded Text Box for the Macro Option ............... 801
  Editing Keyboard Shortcuts .............................................. 802
  Saving, Loading, and Unloading Your Customizations ............... 803
  Understanding the Diesel Macro Language ............................ 804
    Using Diesel at the Command Line .................................. 805
    Using Diesel in a Custom Menu Macro ............................... 806
    Using Diesel as a Menu Option Label ............................... 807
    Using Diesel and Fields to Generate Text .......................... 809
  Creating Custom Linetypes .............................................. 810
    Viewing Available Linetypes ......................................... 810
    Creating a New Linetype ............................................... 811
    Understanding the Linetype Code .................................... 812
    Creating Complex Linetypes ......................................... 813
  Creating Hatch Patterns .................................................. 815
    The Bottom Line .......................................................... 817
Appendix A • Installing and Setting Up AutoCAD ............................. 895
Before Installing AutoCAD ......................................................... 895
Proceeding with the Installation ............................................... 895
Installing the AutoCAD Software ............................................... 896
Configuring AutoCAD .............................................................. 896
The Files Tab ..................................................................... 897
The Display Tab ................................................................ 900
The Open And Save Tab ....................................................... 902
The Plot And Publish Tab ...................................................... 905
The System Tab .................................................................. 905
The User Preferences Tab ..................................................... 907
The Drafting Tab .................................................................. 909
The 3D Modeling Tab ........................................................... 911
The Selection Tab .................................................................. 912
The Profiles Tab .................................................................... 914
Configuring the Tablet Menu Area .......................................... 915
Turning On the Noun/Verb Selection Method ......................... 916
Turning On the Grips Feature .................................................. 916
Setting Up the Tracking Vector Feature ................................. 916
Adjusting AutoCAD’s 3D Graphics System ............................ 917
The Adaptive Degradation Group .......................................... 917
The Hardware And Performance Tuning Group ..................... 917
The Manual Performance Tuning Dialog Box ......................... 918
Finding Hidden Folders That Contain AutoCAD Files ............ 919

Appendix B • Hardware and Software Tips ................................. 921
The Graphics Display .............................................................. 921
Pointing Devices .................................................................. 922
Output Devices ..................................................................... 922
Fine-Tuning the Appearance of Output ................................. 922
Making Detailed Adjustments with the Printer/Plotter ........... 922
Configuration Options ......................................................... 922
Adding a Plot Stamp ............................................................ 928
Controlling How Lines Overlap ............................................. 929
Filtering Paper Sizes ........................................................... 930
Filtering Printers .................................................................. 930
Controlling the Plot-Preview Background Color .................. 930
Controlling the Windows Metafile Background Color .......... 931
Memory and AutoCAD Performance .................................... 931
AutoCAD and Your Hard Disk ............................................... 931
Keep Your Hard Disk Clean .................................................. 932
AutoCAD Tools to Improve Memory Use ............................... 932
Using Partial Open to Conserve Memory and Improve Speed . 932
Using Spatial and Layer Indexes to Conserve Memory .......... 933
Using the Incremental Save Percentage to Conserve Disk Space 933
Setting Up Architectural Desktop to Act Like Standard AutoCAD 933
When Things Go Wrong ......................................................... 934
Starting Up or Opening a File ............................................... 934
Restoring Corrupted Files ..................................................... 935
Troubleshooting Other Common Problems ........................... 935
Appendix C • System Variables and Dimension Styles .......................... 939
  System Variables ........................................................................ 939
  Taking a Closer Look at the Dimension Style Dialog Boxes .................. 940
    The Dimension Style Manager Dialog Box ...................................... 940
    The New/Modify/Override Dimension Style Dialog Box ...................... 943
  Notes on Metric Dimensioning ...................................................... 954
  Drawing Blocks for Your Own Dimension Arrows and Tick Marks ............. 954

Index ............................................................................................. 957
Part 1

The Basics

In this part:

◆ Chapter 1: Exploring the AutoCAD and AutoCAD LT Interface
◆ Chapter 2: Creating Your First Drawing
◆ Chapter 3: Setting Up and Using AutoCAD’s Drafting Tools
◆ Chapter 4: Organizing Objects with Blocks and Groups
◆ Chapter 5: Keeping Track of Layers, Blocks, and Files
Chapter 1

Exploring the AutoCAD and AutoCAD LT Interface

Before you can start to use AutoCAD 2008’s new capabilities, you’ll need to become familiar with the basics. If you’re completely new to AutoCAD, you’ll want to read this first chapter carefully. It introduces you to many of AutoCAD’s basic operations, such as opening and closing files, getting a close-up look at part of a drawing, and changing a drawing. If you’re familiar with earlier versions of AutoCAD, you should review this chapter anyway to get acquainted with features you haven’t already used.

Autodesk has recently changed its AutoCAD update strategy to release new versions every year. Part of this strategy is to introduce new items that focus on a particular category of features. This latest version, AutoCAD 2008, includes several new features focused on 2D drafting. AutoCAD now sports a new tool panel called a dashboard which includes the most common tools needed to produce technical drawings of all types. The ability to setup the scale of drawings has been improved and there are more learning resources at your fingertips.

You’ll get a chance to explore these new features in Part 4 as you work through this book; but for now, let’s get started with some basics.

Topics in this chapter:

◆ Using the AutoCAD Window
◆ Opening an Existing File
◆ Getting a Closer Look with the Zoom Command
◆ Saving a File as You Work
◆ Making Changes and Opening Multiple Files

TIP In this chapter, and throughout the rest of the book, when I say AutoCAD, I mean both AutoCAD and AutoCAD LT. Some topics apply only to AutoCAD. In those situations, you’ll see an icon indicating that the topic applies only to AutoCAD and doesn’t apply to AutoCAD LT. If you’re using AutoCAD 2008 LT, these icons can help you focus on the topics that are more relevant to your work.

Taking a Guided Tour

In this section, you’ll get a chance to familiarize yourself with the AutoCAD screen and how you communicate with AutoCAD. As you do the exercises in this chapter, you’ll also get a feel for how to work with this book. Don’t worry about understanding or remembering everything you see in this chapter. You’ll get plenty of opportunities to probe the finer details of the program as you work through the later chapters. To help you remember the material, you’ll find a brief exercise at the end of each chapter. For now, just enjoy your first excursion into AutoCAD.
NOTE  AutoCAD 2008 is designed to run on Windows 2000, Windows XP and Windows Vista. This book was written using AutoCAD 2008 on Windows XP Professional with a Windows Classic desktop theme.

If you already installed AutoCAD and are ready to jump in and take a look, proceed with the following steps to launch the program:


2. The opening greeting, called a splash screen, tells you which version of AutoCAD you’re using, to whom the program is registered, and the AutoCAD dealer’s name and phone number, should you need help. If this is the first time you’ve started AutoCAD after installing it, you’ll also see a dialog box asking you to register the product.

3. After the splash screen closes, you see the Workspace screen. (You won’t see this in LT.) This screen allows you to select between the 2D drawing workspace called 2D Drafting & Annotation and the 3D workspace called 3D Modeling. A third option called AutoCAD Classic offers the 2D drawing workspace from earlier versions of AutoCAD. Workspaces are saved arrangements of the AutoCAD window. You’ll explore the 3D Modeling workspace in Part 4.

4. You may also see the New Features Workshop screen, which offers a set of tutorials showing you the new features of AutoCAD 2008. Click the No, Don’t Show Me This Again or Maybe Later radio button, and click OK. You can always get to the New Features Workshop screen from the AutoCAD help menu by choosing Help ➤ New Features Workshop.

5. The AutoCAD window displays a blank default document named Drawing1.dwg, as shown in Figure 1.1. AutoCAD users may see the Sheet Set Manager palette to the left of the AutoCAD window, which doesn’t appear in Figure 1.1, to show more of the drawing area. LT users may see the Info palette to the left of the AutoCAD window.

Figure 1.1  A typical arrangement of the elements in the AutoCAD window. The Sheet Set Manager palette (or Info palette for LT) is closed for clarity.
If this is the first time you’ve started AutoCAD since you installed it, you’re asked to register and authorize AutoCAD in step 2. If you’re using the Trial version, you can use the default serial number 000-00000000 for the one-month trial. After you’ve entered the registration information, you see the New Features Workshop window described in step 4.

Let’s look at the AutoCAD window in detail. Don’t worry if it seems like a lot of information. You don’t have to memorize it, but by looking at all the parts, you’ll be aware of what is available in a general way.

**IF YOUR AUTOCAD WINDOW DOESN’T LOOK LIKE FIGURE 1.1**

As you saw in step 3 in the opening exercise, you have a choice between three workspaces when you start AutoCAD. If you didn’t see the Workspace screen, and your drawing opens to a 3D Modeling workspace (see Figure 1.2, later in this chapter), do the following to get to the 2D Drafting & Annotation workspace:

1. Click the Workspaces list in the upper-left corner of the AutoCAD window, and select 2D Drafting & Annotation. LT users can select 2D Drafting & Annotation from the floating Workspaces toolbar.

2. AutoCAD users, choose File > New. Then, in the Select Template dialog box, choose acad.dwt and click Open. LT users can skip this step.

If you did step 2, the default filename is Drawing2.dwg instead of Drawing1.dwg. Aside from that, your AutoCAD window will look similar to Figure 1.1, which shows AutoCAD in a moderate resolution screen.
CHAPTER 1 EXPLORING THE AUTOCAD AND AUTOCAD LT INTERFACE

The AutoCAD Window

The AutoCAD program window is divided into six parts:

- Menu bar
- Toolbars
- Drawing area
- Command window
- Status bar
- Dashboard

Figure 1.1, shown earlier in this chapter, shows a typical layout of the AutoCAD program window. Along the top is the menu bar, and just below that are the Workspaces and Standard Annotation toolbars. At the bottom are the Command window and the status bar. To the right is the Dashboard. The drawing area occupies the rest of the screen. AutoCAD calls the window layout a workspace; you can save and recall a workspace at any time using the Workspaces toolbar. The workspace in Figure 1.1 is called the 2D Drafting & Annotation workspace.

TIP Your screen may show the drawing area in black. You can set the drawing area background color by using the Options dialog box. Appendix A describes how to do this. The figures in this book show the drawing area background in white for clarity.

Figure 1.2 shows AutoCAD’s 3D Modeling workspace, which has a different set of screen elements. Figure 1.2 also shows a standard AutoCAD drawing file with a few setting changes to give it a 3D appearance. Beneath these external changes, the underlying program is the same.

TIP You’ll learn more about workspaces later in this chapter and in Chapter 26.
The menu bar at the top of the drawing area (as shown in Figure 1.3) includes drop-down menus from which you select commands in a typical Windows fashion. The toolbars and Dashboard provide a variety of commands through tool buttons and drop-down lists.

The drawing area occupies most of the screen. Everything you draw appears in this area. As you move your mouse around, crosshairs appear to move within the drawing area. This is the drawing cursor that lets you point to locations in the drawing area.

At the bottom of the drawing area is a set of tabs. These tabs give you access to the Layout views of your drawing. These views let you lay out your drawing as in a desktop publishing program. You’ll learn about the Layout tabs in Chapter 8. The arrows to the left of the tabs let you navigate the tabs when there are more tabs than can fit in the AutoCAD window.

**TURNING ON THE TABS**

If you don’t see the tabs, don’t worry. AutoCAD can be set up to hide the tabs, but you can easily restore them to view. To turn them on, locate the Model tool in the status bar at the bottom of the AutoCAD window.

Right-click the Model tool, and then select Display Layout and Model Tabs. The tabs will appear just below the drawing area. To hide the tabs, right-click any tab, and select Hide Layout and Model Tabs.

The Command window, located just below the Layout tabs, gives you feedback about AutoCAD’s commands as you use them. You can move and resize this window just as you move and resize toolbars. By default, the Command window is in its docked position, as shown in Figure 1.4.

**FIGURE 1.3**
The menu bar, the Workspaces toolbar, and the Standard Annotation toolbar. LT users may see a floating Workspaces toolbar instead of the docked version shown at far right.

**FIGURE 1.4**
The Command window and the status bar
Below the Command window is the status bar (see Figure 1.4). The status bar gives you information at a glance about the state of the drawing. For example, the coordinate readout toward the far left of the status bar tells you the location of your cursor.

**PICKING POINTS IN THE DRAWING AREA**

Now that you’ve seen the general layout of AutoCAD, try using the coordinate readout and the drawing cursor to get a sense of how the parts of the AutoCAD screen work together:

1. Move the cursor around in the drawing area. As you move it, notice how the coordinate readout changes to tell you the cursor’s location. It shows the coordinates in an X, Y, Z format.

2. Place the cursor in the middle of the drawing area, and click the left mouse button. Move the cursor, and a rectangle follows. This is a window selection; you’ll learn more about this window in Chapter 2. You also see a coordinate readout following the cursor and a message asking you to Specify opposite corner:. This display at the cursor is called the dynamic input. You’ll learn more about it a little later in this chapter.

**TIP** If you don’t see the dynamic input display, click the button labeled DYN in the status bar to turn it on.

3. Move the cursor a bit in any direction; then, click the left mouse button again. Notice that the window selection disappears, as does the dynamic input display.

4. Try picking several more points in the drawing area. Notice that as you click the mouse, you alternately start and end a window selection.

If you happen to click the right mouse button, a shortcut menu appears. A right-click frequently opens a menu containing options that are context sensitive. This means the contents of the shortcut menu depend on the location where you right-click as well as the command that is active at the time of your right-click. If there are no appropriate options at the time of the right-click, AutoCAD treats the right-click as an . . . You’ll learn more about these options as you progress through the book. For now, if you happen to open this menu by accident, press the Esc key to close it.

**THE UCS ICON**

In the lower-left corner of the drawing area, you see an L-shaped arrow. This is the User Coordinate System (UCS) icon, which tells you your orientation in the drawing. This icon becomes helpful as you start to work with complex 2D drawings and 3D models. The X and Y arrows indicate the X and Y axes of your drawing. The little square at the base of the arrows tells you that you’re in what is called the World Coordinate System. Chapter 21 discusses this icon in detail. For now, you can use it as a reference to tell you the direction of the axes.
The Command Window
At the bottom of the screen, just above the status bar, is a small horizontal window called the Command window. Here, AutoCAD displays responses to your input. By default, it shows two lines of text. The bottom line shows the current messages, and the top line shows messages that have scrolled by or, in some cases, components of the current message that don’t fit in a single line. Right now, the bottom line displays the message Command (see Figure 1.4, earlier in this chapter). This prompt tells you that AutoCAD is waiting for your instructions. When you click a point in the drawing area, you see the message Specify opposite corner: At the same time, the cursor starts to draw a window selection that disappears when you click another point. The same message appears in the dynamic input display at the cursor.

As a new user, pay special attention to messages displayed in the Command window and the dynamic input display because this is how AutoCAD communicates with you. Besides giving you messages, the Command window records your activity in AutoCAD. You can use the scroll bar to the right of the Command window to review previous messages. You can also enlarge the window for a better view. (Chapter 2 discusses these components in more detail.)

Now, let’s look at AutoCAD’s window components in detail.

The Drop-Down Menus
As in most Windows programs, the drop-down menus on the menu bar provide an easy-to-understand way to access AutoCAD’s general controls and settings. In these menus, you’ll find the commands and functions that are the heart of AutoCAD. By clicking menu items, you can cut and paste items to and from AutoCAD, change the settings that make AutoCAD work the way you want it to, set up the measurement system you want to use, access the help system, and much more.

The drop-down menu options perform three basic functions:

- Display a dialog box that contains settings you can change.
- Issue a command to create or modify your drawing.
- Offer an expanded set of the same tools found in the Draw and Modify toolbars.

As you point to commands and options in the menus, AutoCAD provides additional help for you in the form of brief descriptions of each menu option, which appear in the status bar.

If You Can’t Find the UCS Icon
The UCS icon can be turned on and off, so if you’re on someone else’s system and you don’t see the icon, don’t panic. If you don’t see the icon or it doesn’t look as it does in this chapter, see Chapter 21 for more information.
CHAPTER 1  EXPLORING THE AUTOCAD AND AUTOCAD LT INTERFACE

Here’s an exercise to let you practice with the drop-down menus and get acquainted with the way you issue AutoCAD commands:

1. Click View in the menu bar. The list of items that appears includes the commands and settings that let you control the way AutoCAD displays your drawings. Don’t worry if you don’t understand them yet; you’ll get to know them in later chapters.

2. Move the highlight cursor slowly down the list of menu items. As you highlight each item, notice that a description of it appears in the status bar at the bottom of the AutoCAD window. These descriptions help you choose the menu option you need.

3. Some of the menu items have triangular pointers to their right. This means the command has additional choices. For instance, highlight the Zoom item, and another set of options appears to the right. This second set of options is called a cascading menu. Whenever you see a drop-down menu item with the triangular pointer, you know that this item opens a cascading menu offering a more detailed set of options.

4. Other drop-down menu options are followed by an ellipsis (…). This indicates that the option displays a dialog box. For instance, move the highlight cursor to the Tools option in the menu bar.

WARNING  LT users won’t see the Render option in the View menu.

TIP  If you look carefully at the command descriptions in the status bar, you’ll see an odd word at the end. This is the keyboard command equivalent to the highlighted option in the menu or toolbar. You can type these keyboard commands to start the tool or menu item that you’re pointing to. You don’t have to memorize these command names, but knowing them will be helpful to you later if you want to customize AutoCAD.

TIP  If you prefer, you can click and drag the highlight cursor over the drop-down menu to select an option.
5. Click the Draw option from the menu bar, and then click the Rectangle command. Notice that the Command window now shows the following prompt:

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:

AutoCAD is asking you to select the first corner for the rectangle, and, in brackets, it’s offering a few options that you can take advantage of at this point in the command. Don’t worry about those options right now. You’ll have an opportunity to learn about command options in Chapter 2. You also see the same prompt, minus the bracketed options, in the dynamic input display at the cursor.

6. Click a point roughly in the lower-left corner of the drawing area, as shown in Figure 1.5. Now, as you move your mouse, a rectangle follows the cursor, with one corner fixed at the position you just selected. You also see the following prompt in the Command window, with a similar prompt in the dynamic input display:

Specify other corner point or [Area/Dimensions/Rotation]:

![Figure 1.5](image-url)

Selecting the first point of a rectangle

7. Click another point anywhere in the upper-right region of the drawing area. A rectangle appears (see Figure 1.6). You’ll learn more about the different cursor shapes and what they mean in Chapter 2.

At this point, you’ve seen how most of AutoCAD’s commands work. Many drawing and editing functions display messages in the Command window. These messages are also displayed in the dynamic input display. You’ll find that dialog boxes are displayed when you want to change settings. Also, be aware that many of the drop-down menu items are duplicated in the toolbars, which you’ll explore next.
CHAPTER 1 EXPLORING THE AUTOCAD AND AUTOCAD LT INTERFACE

Figure 1.6
After you’ve selected the first point of the rectangle, you see a rectangle follow the motion of your mouse.

Communicating with the Command Window and Dynamic Input Display

AutoCAD is the perfect servant: It does everything you tell it to, and no more. You communicate with AutoCAD by using the drop-down menus and the toolbars. These devices invoke AutoCAD commands. A command is a single-word instruction you give to AutoCAD, telling it to do something, such as draw a line (the Line tool in the Draw toolbar) or erase an object (the Erase tool in the Modify toolbar). Whenever you invoke a command, by either typing it or selecting a menu or toolbar item, AutoCAD responds by presenting messages to you in the Command window and the dynamic input display or by displaying a dialog box.

The messages in the Command window often tell you what to do next, or they display a list of options, usually shown in square brackets. A single command often presents a series of messages, which you answer to complete the command. These messages serve as an aid to new users who need a little help. If you ever get lost while using a command or forget what you’re supposed to do, look at the Command window for clues. As you become more comfortable with AutoCAD, you’ll find that you won’t need to refer to these messages as frequently.

As an additional aid, you can right-click to display a context-sensitive shortcut menu. If you’re in the middle of a command, this menu displays a list of options specifically related to that command. For example, if you right-click your mouse before picking the first point for the rectangle command in the previous exercise, a menu opens, displaying the same options that are listed in the Command prompt plus some additional options.

Finally, the dynamic input display allows you to enter dimensional data of objects as you draw them. Besides echoing the command-line messages, the dynamic input display shows the coordinates and angles of objects you’re drawing and editing. As you enter coordinate or angle values through the keyboard, they appear in the dynamic input display. If you’re used to earlier versions of AutoCAD, you can easily turn off the dynamic input display by clicking the DYN button in the status bar. When the dynamic input display is turned off, your keyboard input appears in the Command window.
The Dashboard
The menu bar provides most of the commands you need in a format that most Windows users will find easy to understand, and many users are more comfortable using the menu bar. If you prefer using toolbars with their graphic icons, you can start to use the Dashboard. The Dashboard offers many of the same commands as the menu bar but in a more compact format that is quicker to access.

The Dashboard is a collection of lists, buttons, and tools that invoke commands. These tools are grouped into eight control panels, each with an icon that shows its function (see Figure 1.7). In typical Windows fashion, each tool offers a ToolTip that provides a short description, which helps you understand what the icons represent.

**Figure 1.7**
The control panels of the Dashboard

NOTE If the Dashboard doesn’t appear on the screen, you can choose Tools ➔ Palettes ➔ Dashboard to restore it to the window.

If you move the arrow cursor onto one of the control-panel tools and leave it there for a moment, you’ll see a ToolTip appear just below the cursor. As a new user, you’ll find these ToolTips helpful because they show you the name of the tool. In addition, when I ask you to select a tool, I’ll use the name shown in the ToolTip. For example, if you hover over the icon in the upper-left corner of the Dashboard, you’ll see a ToolTip appear with the name of the control panel, 2D Draw.
Take a moment to examine the top portion of the Dashboard where the 2D Draw control panel resides. You’ll be instructed to use the tools in this control panel frequently throughout the early part of this book, so it will be helpful for you to get a feel for their arrangement and what they contain. You’ll get a closer look at the Dashboard and control panels in Chapter 2.

In addition to the visible tools, a few tools are hidden from view. You can expand the list of tools to select more tools. Click and hold the downward-pointing arrow to the far right of the row of tools (see Figure 1.8). The set of tools expands into a fly-out toolbar. While continuing to hold down the mouse button, you can point to the tool you want in the fly-out toolbar and then release the mouse.

In most cases, you’ll be able to guess what each tool does by looking at its icon. The icon with an arc in the 2D Draw control panel, for instance, indicates that the tool draws arcs; the one with the circle shows that the tool draws circles; and so on. For further clarification, the ToolTip gives you the name of the tool.

**The Toolbars**

The menu bar and Dashboard offer the most frequently used tools, but you’ll eventually find that you need to use a set of tools geared toward a specific task. AutoCAD offers a number of toolbars that contain tools for specific types of drawing functions. For example, the View toolbar offers a set of tools that quickly give you a 3D view. The Inquiry toolbar contains tools that display information about your drawing.

AutoCAD displays the Workspaces and Standard Annotation toolbars in its default 2D Drafting & Annotation workspace. As you work through this book, occasionally you’ll be asked to open other toolbars. To get familiar with the process, try opening a one now.

1. Right-click the Workspaces or Standard Annotation toolbar. A shortcut menu of toolbars appears, displaying a long list of toolbars, as shown in Figure 1.9.

2. Locate and select View in the shortcut menu (see Figure 1.9). The View toolbar appears.
3. You won’t need the View toolbar right now, so go ahead and close it by clicking the X in the upper-right corner of the toolbar.

You may have noticed that the shortcut menu displays a check mark next to the name of a toolbar that is currently open (see Figure 1.9). You can click a checked toolbar name to close the toolbar. AutoCAD remembers your toolbar arrangement between sessions. When you exit and then reopen AutoCAD later, the AutoCAD window appears just as you left it.

NOTE  If your drawing becomes too cluttered with toolbars, you can drag a toolbar to the border of the AutoCAD window, and it will automatically merge with the border. This is called its docked position. If you don’t want the toolbar to dock but instead want it to appear floating near the border of the AutoCAD window, you can do the following: First, change the shape of the toolbar to conform to the orientation of the border. Do this by clicking and dragging the toolbar’s border. Next, press and hold the Ctrl key as you click and drag the toolbar into position near the border. This prevents the toolbar from automatically falling into a docked position.

**SAMPLE TEXT**

**FIGURE 1.9**
The toolbar shortcut menu

**MENUS VERSUS THE KEYBOARD**

Throughout this book, you’ll be told to select commands and command options from the drop-down menus and toolbars. For new and experienced users alike, menus and toolbars offer an easy-to-remember method for accessing commands. If you’re an experienced AutoCAD user who is used to the earlier versions of AutoCAD, you can type commands directly from the keyboard. Most of the keyboard commands you know and love still work as they did.

Another method for accessing commands is to use accelerator keys, which are special keystrokes that open and activate drop-down menu options. You may have noticed that the commands in the menu bar and the items in the drop-down menus all have an underlined character. By pressing the Alt key followed by the key corresponding to the underlined character, you activate that command or option without having to engage the mouse. For example, to choose File ➤ Open, press Alt, then F, and then finally O (Alt+F+O).
Saving Your Preferred Workspace

You may find that you prefer a specific arrangement of toolbars that you’d like to be able to recall at will. You can rearrange the toolbars and then save the arrangement as a named workspace. Doing so can be useful if you must share your AutoCAD workstation with someone else who prefers their own AutoCAD window layout or if you want to set up different arrangements for different types of work. For example, you might want to save the current AutoCAD window layout with the Tool palettes out of the way, while someone else prefers the default AutoCAD setup. To save the current setup under a new name, do the following:

1. In the Workspaces toolbar, click in the drop-down list, and select Save Current As to open the Save Workspace dialog box.

2. Enter My Custom Layout in the text box, and click Save. The current arrangement of AutoCAD components is saved under the name My Custom Layout.

3. To recall a workspace, select the name of the saved workspace from the drop-down list in the Workspaces toolbar.

You may have noticed a house icon in the Workspaces toolbar. This is the My Workspace tool, which offers a quick way to restore your favorite workspace. You can customize the My Workspace tool to recall any AutoCAD window layout you like. You’ll learn more about creating and customizing workspaces in Chapter 26.

Working with AutoCAD

Now that you’ve been introduced to the AutoCAD window, you’re ready to try using a few AutoCAD commands. First, you’ll open a sample file and make a few modifications to it. In the process, you’ll become familiar with some common methods of operation in AutoCAD.

Opening an Existing File

In this exercise, you’ll get a chance to see and use a typical Select File dialog box. To start, you’ll open an existing file:

1. From the menu bar, choose File > Close. A message appears, asking whether you want to save the changes you’ve made to the current drawing. Click No.
2. Choose File ➤ Open to open the Select File dialog box. This is a typical Windows file dialog box, with an added twist: The large Preview box on the right lets you preview a drawing before you open it, thereby saving time while searching for files. To the left is a panel known as the Places List in which you can find frequently used locations on your computer or the Internet.

3. In the Select File dialog box, open the Look In drop-down list, and locate the \2008acad2008\samplefiles\Mastering AutoCAD 2008\Projects\Chapters 01 folder. (You may need to explore the list to find it.) The file list changes to show the contents of the \AutoCAD 2008\Projects\Chapter 01 folder.

4. Move the arrow cursor to the clip.dwg file, and click it. Notice that the clip.dwg filename now appears in the File Name input box above the file list. Also, the Preview box now shows a thumbnail image of the file. Be aware that files from older versions of AutoCAD may not show a thumbnail.

5. Click the Open button at the bottom of the Select File dialog box. AutoCAD opens the clip.dwg file, as shown in Figure 1.10.

The clip.dwg file opens to display a Layout tab view of the drawing. You’ll know this by looking at the tabs at the bottom of the AutoCAD window. Currently, the Layout1 tab is highlighted.
You may recall that a layout is a type of view that lets you lay out different views of your drawing in preparation for printing. Also notice that the AutoCAD window’s title bar displays the name of the drawing. This offers easy identification of the file.

This particular file contains both 2D drawings and a 3D model of a typical locking clip. The Layout1 tab view shows a top, front, and right-side view as well as an isometric view.

**Getting a Closer Look**

One of the most frequently used commands is Zoom, which gives you a closer look at part of your drawing. This command offers a variety of ways to control your view. In this section, you’ll enlarge a portion of the clip drawing to get a more detailed look. To tell AutoCAD which area you want to enlarge, you use what is called a zoom window.

You’ll start by switching to a Model Space view of the drawing. The Model tab places you in a workspace where you do most of your drawing creation and editing. Follow these steps:

1. Click the Model tab at the bottom of the AutoCAD window.
Your view changes to show the full 3D model with the 2D representations of the model.

2. Choose View ➤ 3D Views ➤ Plan View ➤ World UCS. You can also type \texttt{PLAN}\texttt{W}. Your display changes to a two-dimensional view looking down on the drawing, as shown in the top image of Figure 1.11.

Click the Zoom Window button on the Standard toolbar.

You can also choose View ➤ Zoom ➤ Window from the drop-down menu or type the command \texttt{Z}\texttt{W}.

3. The Command window and the dynamic input display show the Specify first corner: prompt. Look at the top image in Figure 1.11. Move the crosshair cursor to a location similar to the one shown in the figure; then, left-click the mouse. Move the cursor, and the rectangle appears with one corner fixed on the point you just picked; the other corner follows the cursor.

4. The Command window and dynamic input display now show the Specify first corner: and Specify opposite corner: prompts. Position the other corner of the zoom window so it encloses the lower image of the clip, as shown in the top image in Figure 1.11, and left-click the mouse again. The clip enlarges to fill the screen (see the bottom image in Figure 1.11).

In this exercise, you used the Window option of the Zoom command to define an area to enlarge for your close-up view. You saw how AutoCAD prompts you to indicate first one corner of the window selection and then the other. These messages are helpful for first-time users of AutoCAD. You’ll use the Window option frequently—not just to define views, but also to select objects for editing.
Getting a close-up view of your drawing is crucial to working accurately, but you'll often want to return to a previous view to get the overall picture. To do so, choose View ➔ Zoom ➔ Previous from the menu bar.

Do this now, and the previous view—the one showing the entire clip—returns to the screen.
You can quickly enlarge or reduce your view by clicking the Zoom Realtime button in the 2D Navigate control panel. Follow these steps to change your view with the Zoom Realtime button:

1. **Click the Zoom Realtime button on the 2D Navigate control panel of the Dashboard.**
2. Place the Zoom Realtime cursor slightly above the center of the drawing area, and then click and drag downward. Your view zooms out to show more of the drawing.
3. While still holding the left mouse button, move the cursor upward. Your view zooms in to enlarge your view. When you have a view similar to the one shown in Figure 1.12, release the mouse button. (Don’t worry if you don’t get exactly the same view as the figure. This is just for practice.)
4. You’re still in Zoom Realtime mode. Click and drag the mouse again to see how you can further adjust your view. To exit, you can select another command besides a Zoom or Pan, press the Esc key, or right-click your mouse and choose Exit from the shortcut menu.
5. Right-click now, and choose Exit from the shortcut menu to exit the Zoom Realtime command.

**Figure 1.12**
The final view you want to achieve in step 3 of the exercise
As you can see from this exercise, you have a wide range of options for viewing your drawings, just by using a few buttons. These buttons are all you need to control the display of 2D drawings.

**Saving a File as You Work**

It’s a good idea to save your file periodically as you work on it. As with any Windows program, you can save it under its original name (choose File ➤ Save) or under a different name (choose File ➤ Save As), thereby creating a new file.

By default, AutoCAD automatically saves your work at 10-minute intervals under a name that is a combination of the current filename plus a number and that ends with the .sv$ filename extension; this is known as the *Automatic Save* feature. Using settings in the Options dialog box or system variables, you can change the name of the autosaved file and control the time between autosaves. See Chapter 3 for details.

**TIP** By default, in Windows XP, the Automatic Save file is stored in \Documents and Settings\User Name\Local Settings\Temp\$. You can find the exact location for your system by typing `Savefilepath` ø at the Command prompt. This file location is often set as a hidden folder, so you may need to set up Windows Explorer to display hidden folders before you can get to the Automatic Save file. See Appendix A for information on how to do this.

**Making Changes**

You’ll frequently make changes to your drawings. One of AutoCAD’s primary advantages is the ease with which you can make changes. The following exercise shows you a typical sequence of operations involved in changing a drawing:

1. Use the File ➤ Save As menu option to save the current *Clip.dwg* file under the name *MyFirst*. For convenience, you can save your files in the *My Documents* folder.

2. From the 2D Draw control panel, click the Erase tool (the one with a pencil eraser touching paper). This activates the Erase command. You can also choose Modify ➤ Erase from the drop-down menu.

   Notice that the cursor has turned into a small square; this square is called the *pickbox*. You also see *Select objects:* in the Command window and the dynamic input display. This message helps remind new users what to do.

3. Move the pickbox over the drawing, placing it on various parts of the clip. Don’t click anything yet. Notice that as you hover over objects with the pickbox, they’re highlighted. This helps you see the objects the pickbox is likely to select, should you click the left mouse button.

4. Place the pickbox on the crosshatch pattern of the clip (see Figure 1.13), and click. The crosshatch changes in appearance from a dark highlight to a light highlight. The pickbox and the *Select objects:* prompt remain, indicating that you can continue to select objects.

5. Press ↵. The crosshatch disappears. You’ve just erased a part of the drawing.

   In this exercise, you first issued the Erase command, and then you selected an object by using a pickbox to click it. The pickbox tells you that you must select items on the screen, and it shows you what you’re about to select by highlighting objects as you hover over them. Once you’ve clicked an object or a set of objects, press ↵ to move on to the next step. This sequence of steps is common to many of the commands you’ll work with in AutoCAD.

**TIP** You can also click an object or a set of objects and then press the Delete key without using the Erase tool.
Opening Multiple Files
You can have multiple documents open at the same time in AutoCAD. This can be especially helpful if you want to exchange parts of drawings between files or if you want another file open for reference. Try the following exercise to see how multiple documents work in AutoCAD:

1. Choose File ➔ New to open the Select Template dialog box.

**NOTE** If you see the Create New Drawing dialog box after step 1, click the Start from Scratch button and select Imperial; then, click OK, and AutoCAD will display a default document. You’ll learn more about the Create New Drawing dialog box in Chapter 2.

2. Make sure acad.dwt is selected, and then click Open.

3. Choose Window ➔ Tile Vertically to get a view of both drawing files. The options in the Window drop-down menu act just like their counterparts in other Windows programs that allow multiple-document editing.

**TIP** When you create a new file in AutoCAD, you’re actually opening a copy of a template file, as you saw in step 1. A *template file* is a blank file that is set up for specific drawing types. The acad.dwt file is a generic template set up for Imperial measurements. Another template file called acadiso.dwt is a generic template useful for metric measurements. Other templates are set up for specific drawing-sheet sizes and measurement systems. You’ll learn more about templates in Chapter 6.
4. Let’s see what can be done with these two files. Click in the window with the clip drawing to make it active.

5. Choose View ➔ Zoom ➔ All to get an overall view of the drawing.

6. Click the 2D version of the clip at the bottom of the drawing to select it. A series of squares and arrows appears on the drawing. These are called grips, and you’ll learn more about them in the next chapter.

7. Click and hold the mouse button on the selected object, but avoid clicking any of the blue squares. Also avoid dragging the object. You’ll see a small rectangle appear next to the cursor.

8. While still holding the left mouse button, drag the cursor to the new file window. When you see the clip appear in the new drawing window, release the mouse button. You’ve just copied part of a drawing from one file to another.

9. This ends the exercises for this chapter. Save the file and then exit AutoCAD.

**NOTE** You can also use the standard Windows Copy and Paste options (Edit ➔ Copy and Edit ➔ Paste from the menu bar) to copy objects from one window to the other.

Now you’ve had two files open at once. You can have as many files open as you want, as long as your computer has adequate memory to accommodate them. You can control the individual document windows as you would any window, using the Window drop-down menu or the window control buttons in the upper-right corner of the document window.

**Adding a Predrawn Symbol with the Tool Palette**

In the preceding exercise, you saw how you can easily copy an object from one file to another by using a click-and-drag method. AutoCAD offers a Tool Palettes window that lets you click and drag predrawn objects into your drawing.
You can open the Tool Palettes window by clicking the Tool Palettes Window tool in the Standard Annotation toolbar. Once it’s open, you can select a tab containing the predrawn objects you want to use and then click the specific object you want to add. The object appears at the cursor, ready for you to select a location.

In addition to predrawn objects, the Tool palettes offer a way to quickly add fill patterns and other components to your drawing. They’re great tools to help you manage your library of custom, predrawn symbols. Chapter 25 shows you how to use and customize the Tool palettes.

The Bottom Line

Using the AutoCAD Window  AutoCAD is a typical Windows graphics program that makes use of menus, toolbars, and palettes. If you’ve used other graphics programs, you’ll see at least a few familiar tools.

Master It  Name the components of the AutoCAD window that let you select a function.

Solution  AutoCAD offers the menu bar, toolbars, and the Dashboard to give you access to the most common functions.

Getting a Closer Look with the Zoom Command  One of the first things you’ll want to learn is how to manipulate your views. The Zoom command is a common tool in graphics programs.

Master It  Name two ways of zooming into a view.

Solution  Choose View ➔ Zoom ➔ Window, and then click two points to define a zoom window. Another option is to use the Realtime tool in the 2D Navigate control panel.

Saving a File as You Work  Nothing is more frustrating than having a power failure cause a loss of hours of work. It’s a good idea to save your work frequently. AutoCAD offers an autosave feature that can be a lifesaver if you happen to forget to save your files.

Master It  How often does the AutoCAD autosave feature save your drawing?

Solution  Autosave saves a copy of a drawing every 10 minutes by default. This interval can be set by the user.

Making Changes and Opening Multiple Files  As with other Windows programs, you can have multiple files open and exchange data between them.

Master It  With two drawings open, how can you copy parts of one drawing into the other?

Solution  Select the parts you want to copy, and click and hold on any selected part. When you see a small rectangle appear below the cursor, drag the parts into the other drawing. Alternately, you can use the standard Windows Copy and Paste functions.
Index

Note to the Reader: Throughout this index boldfaced page numbers indicate primary discussions of a topic. Italicized page numbers indicate illustrations.

Symbols

' (apostrophes), 541
* (asterisks)
in AutoLISP, 771
in calculator, 449
in Diesel, 808
in layer filters, 153
with tables, 331
@ (at signs), 34–35
\ (backslashes)
in AutoLISP, 787
in macros, 798
in menus, 801
for spaces, 395
[] <> (brackets)
in calculator, 448
for default options, 39
for linetypes, 813–814
^ (carets)
in calculator, 449
in menus, 801–802
, (commas)
in Cartesian coordinates, 35
in hatch patterns, 815
in linetype patterns, 812
$ (dollar signs)
in Diesel, 804
in importing files, 426
" (double quotes)
in AutoLISP, 770–771
in Diesel, 808
in filters, 432
in tables, 331
= (equal signs)
in AutoLISP, 781
in Diesel, 808
in filters, 432
in tables, 331
! (exclamation points)
in AutoLISP, 768
in Diesel, 808
in filters, 432
> (greater-than symbols)
in AutoLISP, 770, 781
in Diesel, 808
in filters, 432
for text, 353–354
< (less-than symbols)
for angles, 34
in AutoLISP, 781
for degrees, 76
in Diesel, 808
for filters, 432
for text, 353–354
- (minus signs)
in AutoLISP, 771
in calculator, 449
in Diesel, 808
in linetype patterns, 812
for macros, 798
with tables, 331
in units, 75
() (parentheses)
in AutoLISP, 769–772
in calculator, 448
in Diesel, 805
for functions, 763–764
in tables, 331
% (percent signs), 311
( periods), 35, 72
+ (plus signs)
in AutoLISP, 768, 771
in calculator, 449
in Diesel, 805, 808
in menus, 802
with tables, 331
? (question marks)
in layer filters, 153
for system variables, 541
; (semicolons), 800
' (single quotes), 541
/ (slashes)
in AutoLISP, 771, 781, 787
in calculator, 449
in Diesel, 805, 808

for options, 39
with tables, 331
_ (underscores)
in linetype patterns, 811
for text objects, 311
( vertical bars), 426

Numbers

2D Drafting & Annotation workspace, 6
2D Draw control panel for tables, 324
working with, 27–28, 29
2D drawings and objects, converting
to 3D forms, 573–579, 573–579
from 3D models, 259
from 3D views, 590–592, 591–592
from solids, 708–710, 709
2D Wireframe option, 587, 587
3 Point UCS tool, 617
3D Crosshairs settings, 911
3D drawings and models, 559. See also solids and solid modeling
2D drawings from, 259, 590–592, 591–592
from 2D shapes, 573–579, 573–579
aligning objects, 640–642, 641
configuring, 911–912, 912
drawing, 568–569, 569
editing, 593
grips for, 564–566, 564–565
hidden lines, 708
moving objects, 642, 642
Osnaps, 568
point filters for, 580, 581
pushing and pulling shapes, 569–570, 569–571
rendering. See rendering 3D models
rotating objects, 566–568, 566–567, 643, 643, 713–714, 714
solids for, 562–563, 562
Sweep for, 625–632, 625–632
viewing, 581–585
viewports for, 609–612, 609–612
visual effects, 586–590, 586–590
workspace for, 559–562, 560–562
3D Faces
converting solids to, 724
restrictions on, 616
with UCS, 606
3D forms, laying out, 613–614, 613–614
3D Graphics System
Configuration dialog box, 917–919
3D Hidden option, 248
3D Make panel, 561, 561, 598, 598
3D Modeling tab, 911–912, 912
3D Modeling workspace, 6, 6
3D Move tool, 642, 642
3D Navigate panel, 561, 561, 652–653, 659
3D Navigation settings, 911–912
3D Objects settings, 911
3D Orbit tool, 624, 624
3D polylines, 615–616, 616
3D Section option, 736
3D surfaces. See surfaces
3D Wireframe option
Visual Styles, 586–587, 587
volume of cuts, 635, 635
3DArray command, 644
3Dmirror command, 644
3DPerformance settings, 905
3points slice option, 716

A
About option, 64
Above Dimension Text option, 946
Abs function, 445, 449
ACAD_linetypes, 154
Acad.dwt file, 23, 291
Acad.fmp file, 314
Acad.lin file, 154, 810–811
Acad.pat file, 815
Acad.pgp file, 752
Acad.psf file, 898
acad3D.dwt template, 559, 564
AcadCAD log file, 159
acadiso.dwt file, 23
Acadiso.lin file, 154
acceleration, hardware, 918
accelerator keys, 10, 87, 751–752, 751
settings for, 907
troubleshooting, 936
on menus, 802–803, 803
acos function, 449
actions for dynamic blocks
adding, 480–482, 481–482
for arrays, 504–505, 504–505
editing, 484
scale and stretch, 486–490, 487–489
Activate Live Sectioning option, 732
active viewports, 458, 460
Adaptive Degradation And Performance Tuning dialog box
3D performance, 905, 917–919, 917
driver updates, 921
Adaptive option, 279
Add-A-Plot Style Table wizard, 262, 281, 283
Add a Printer option, 255
Add Color-Dependent Plot Style Table Wizard, 270
Add Current Scale tool, 294
Add Custom Property dialog box, 879, 879
Add File button, 820
Add function, 808
Add Jog To Section option, 734
Add New Location listing, 864, 870
Add options
groups, 131
selecting objects, 48
spline curves, 527
AddOrConfigurePlotterstoption, 256, 261
Add Or Edit Plot Style Tables option, 262
Add Parameter Properties dialog box, 493, 493, 495
Add Plot Style dialog box, 283
Add Printer Wizard, 255
Add Profile dialog box, 914
Add/Remove selection mode, 94
Add Scale dialog box, 247, 247
Add Scales To Object dialog box, 124, 124
Add: Select Objects button, 216
Add Sheets tool, 829, 829
Add Standards File button, 850
Add Style option, 280
Add To Dictionary option, 313
Add To Favorites tool, 839
Add To Group option, 132
Add To History option, 762
Add To List option, 914
Add To Working Set tool, 236
addition
areas, 536–538, 536, 538
AutoLISP, 770–771
calculator, 449
Diesel, 805
in tables, 331–332
Additional Angles settings, 80
Additional Resources option, 64
Additional Settings dialog box, 400, 400
Adjust Background Image dialog box, 661, 661
Adjust Bitmap dialog box, 679
Adjust Display Scale option, 470
Adjust Exposure tool, 684
Adjust Image button, 661
Adjust Rendering Exposure dialog box, 684, 699, 699
Adjustment option, 279
ADT (Architectural Desktop 2008), 933–934
Advanced Options dialog box, 929, 929
Advanced Render Settings option, 683
Advanced Render Settings palette, 696–697, 696
Advanced tab in DesignCenter searches, 842
After Primary Value option, 952
AGP Bus, 921
Al command, 640
aliases, command, 751–752, 751
Align option, 310, 310
Align tool, 640
Align Space tool, 758
Aligned tool, 363
Aligned With Dimension Line option, 342, 947
aligning
dimensions, 363, 364, 947
multileader notes, 373
objects
in 3D space, 640–642, 641
with layout objects, 758–759, 759
with Osnap tracking, 97–102, 98–102
with Sweep, 628, 628
text, 301–302, 301, 309–310, 309–310, 327, 327
viewports, 759–761, 760
Alignment option, 628, 628
Alignment Point Acquisition option, 910
All options
selecting objects, 48
zooming, 198, 200
All Borders option, 330
All Cross Sections option, 638
All Used Layers option, 148, 150
Allow Exploding option, 110
Allow Long Symbol Names option, 906
Allow Other Users To Refedit Current Drawing option, 232, 904
Allow reverse Lookup option, 494
Alt key for accelerator keys, 15
alternate dimensions, adding and removing, 362–363
alternate units, 346, 346
Alternate Units tab, 346, 346, 362, 951–952, 951
Always Keep Text Between Ext Lines option, 948
American Institute of Architects layer naming convention, 152–153
AND operations
AutoLISP, 782
grouping, 433
searches, 63
Ang function, 445
Angbase system variable, 75
Angdir system variable, 75
Angle function, 783
Angle Of Line Defined By Two Points tool, 436, 437, 439, 439
angles
arcs, 40, 40
circular copies, 168
dimension lines, 365, 368, 368
dimension text, 355, 358
dimensions for, 365–367, 365
direction for, 73–74, 73
falloff, 670–671, 670–671
hatch patterns, 207, 815
linetypes, 813
with Loft, 639, 640
moving objects, 46–48
multileaders, 370
Polar Tracking, 79, 80
precision for, 73
QuickCalc calculator for, 437–439
revolving polylines, 713
row and column copies, 169
shapes, 755
specifying, 34, 35
styles for, 74–75
text, 296, 296, 308
units for, 76
Xlines, 190
Angtos function, 785
Angular tool, 365
animation
settings, 912
walk-throughs, 690–692, 690
Animation Preview window, 691
Animation Settings button, 912
Annotation Object Scale dialog box, 123–124, 123
annotation scale, 122–125, 122–125, 294–295
Annotative option
blocks, 110
hatch patterns, 217
scales, 948
ANSI format, templates for, 164
Aperture Size option, 910
apostrophes (‘), 541
Apparent Intersection Osnap option, 95
Append to Current Selection Set option, 435
Application Data folders option, 919
Apply Changes To Existing References option, 397
Apply Global Scale Factor To Non-ISO Linetypes option, 278
Apply Material To Objects tool, 657, 657, 678
Apply Selected Visual Style To Current Viewport tool, 588, 588
Apply Solid Fill option, 510, 902
Apply To option, 435
Apply To All Active Viewports option, 604
Apply To Layout Dimensions Only option, 473, 730, 950
Ar command, 385
Arc And Circle Smoothness option, 156, 901
Arc tool, 29, 39, 89, 89
Arc Length tool, 368
Architectural Desktop 2008 (ADT), 933–934
Architectural units, 73–74
Archive A Sheet Set dialog box, 890–891, 890
archiving sheet sets, 889–891, 890–891
arcs, 88–93, 90–91
dimensions, 365–368, 946
distances along, 191–192, 191–192
length, 192, 368
moving, 50
options, 38–42, 40–42
for polylines, 508, 509
properties, 67–68, 67
smoothness, 651, 901
with UCS, 605
Area command, 534–538
Area Fill Correction option, 924
area of objects, 534–535
complex, 536–538, 536, 538
hatch patterns for, 535–536, 536
Area system variable, 541
Area tool, 534
argument lists, 765
arguments
AutoLISP, 770–771
Diesel, 805
functions, 765
Array command, 166–167, 169, 593
Array dialog box, 167, 167, 385, 385
Array tool, 29, 167, 169, 385
arrays, 165–166
for 3D objects, 593
3DArray for, 644
actions for, 504–505, 504
creating, 385
polar, 166–168, 167–169
rectangular, 169–173, 169–173
Arrowhead panel, 371
arrows
blocks for, 954–955, 955
notes with, 369–372, 369
options for, 945
styles for, 342–345, 343–344
Arrows option, 948
As Displayed option, 248, 731
ASCII files, importing, 306–307
asin function, 449
assembling
 cross-references, 420–424, 420–424
 parts, 197–200, 198–200
assigning layers, 140–142, 745–746
Associate Hyperlink option, 888
associating
 standards, 850–851, 850
text with drawing properties, 319–323, 320–322
associative dimensioning, 337, 360–361, 361
options, 909
Paper Space, 471–473, 472
updating, 473
associative hatch patterns, 214, 222, 913
asterisks (*)
 in AutoLISP, 771
with calculator, 449
in Diesel, 808
in layer fillers, 153
with tables, 331
at signs (@), 34–35
atan functions, 449, 772
Atof command, 392
Atof function, 785
Atoi function, 785
atom operator, 781
atoms in AutoLISP, 769
Att command, 384
Attach By Layer tool, 664, 664
Attach Digital Signature After Saving drawing option, 825
Attach Digital Signatures dialog box, 826–827, 826
Attach external reference option, 229
Attach Xdata tool, 756
Attach Xref tool, 420–421, 420
attaching
data to objects, 756
external files, 225–227, 225–227
Attachment option, 230
Attdia system variable, 388
Attdisp command, 394
Attedit command, 393, 395
attenuation properties for lights, 671
Att redefine command, 398
Attribute Definition dialog box, 384–385, 384
modes, 387
view labels, 883–884, 883
Attribute Extraction - Refine Data dialog box, 496, 497
Attribute Extraction - Select Attributes dialog box, 496, 497
Attribute Extraction Wizard, 398–399, 496, 497
Attribute tab
Edit Attribute, 396, 396
Enhanced Attribute Editor, 392–393, 393
attributes, 381
areas, 539
with blocks
adding, 382–385, 383–384
inserting, 388–390, 389–390
redefining, 397–398
copied and editing, 385–388, 385–386
creating, 381–382, 382
definitions for, 385–388, 385–386
depending on, 391–398, 391–393, 396–397
exporting, 398–404
extracting, 398–404, 494–497, 495–497
global changes to, 393–397, 396–397
invisible, 394–395, 395
prompts for, 384, 386
with UCS, 606
Attsync command, 397
Audit option, 545
audit report files, 851–853
AUGI (Autodesk User Group International) option, 64
Aunits system variable, 74
Auprec system variable, 74
authors, storing information on, 544
Auto selection option, 50
AutoCAD 2008 Developer Help window, 787
AutoCAD 2008 Help dialog box Contents tab, 62, 62
for context-sensitive help, 64
AutoCAD 2008 Master Setup dialog box, 896
AutoCAD 2008 Support folder, 846
AutoCAD Alias Editor dialog box, 751, 751
AutoCAD Classic workspace, 559
AutoCAD DesignCenter, 109, 836–839, 837–838
exchanging data between files with, 843
loading files into, 843–844
opening and inserting files with, 840
searching and extracting drawing contents with, 840–842, 840
for symbols, 844
for Tool Palettes, 844–848, 847
AutoCAD Entities OLE option, 554
AutoCAD fonts, 305, 306
AutoCAD Text Window, 66, 66, 158, 543
AutoCAD window, 4, 4
components, 6–8, 6–7
workspace selection in, 5, 5
Autodesk AutoCAD Certified Hardware XML Dataspace page, 921
Autodesk Developer Center, 64
Autodesk DWF Viewer, 830, 830
Autodesk Training site, 64
Autodesk User Group
International (AUGI) option, 64
AutoFit option, 333
AutoLISP program, 761, 767
arguments, 770–771
table structures, 780–783
expressions, 767, 770–771
functions, 770–772
data type conversion,
785–786
geometric, 783–784
string, 784
keyboard macros with,
763–765, 764
lists, 775–776
loading and running programs, 761–763, 761
sample program, 773–778, 774, 778
saving programs, 786–787
for submenus, 802
user input, 775–778, 778
variables, 768–772, 769
automatic operations
OLE link updating, 553
saving, 22, 903
Automatic Save option, 903
Automatically Select All Nested Objects option, 236
Autoselect feature, 51–52
AutoSnap feature, 910
AutoSnap Marker Color option, 92
AutoSnap Marker Size option, 92
Autospool feature, 256, 923
Available Materials In Drawing panel, 655
Average function, 331
axes
Dynamic UCS, 566
ellipses, 81
in rotating, 607–608
Background color
plot preview, 930–931
Windows metafile, 931
Background dialog box, 660, 660
background grids
Grid mode as, 102–104
information on, 540
background plots, 262
Backgroundplot system variable, 250, 262
backgrounds
in Layout tabs, 252, 252
rendering 3D models,
659–661, 659–661
text, 746
backslashes (\)
in AutoLISP, 787
in macros, 798
in menus, 801
for spaces, 395
Backspace key, 33
backwards text, 296
.bak extension, 933
base angles, 75
Base Point Parameter tool, 479
base points
blocks, 108
with inserting symbols,
116–117, 158
for selecting objects, 44–48, 46–47
with stretching, 55
for Sweep, 628, 629
Baseline option, 351–352
Baseline Spacing option, 945
baselines, dimensions from,
351–352, 352
batch plotting
sheet sets, 891–892, 891
with working, 264
Batch Standards Checker,
851–853, 851–852
Batting linetype, 154
BC text option, 310
Beep On Error In User Input option, 906
Begin grouping operator, 433
Below Primary Value option, 952
Beside The Dimension Line option, 347, 948
Binary option for .dxf files, 547
Bind External Reference option,
229, 822
bisecting Xline angles, 190
bitmap images
in 3D models, 671
for buildings, 672–673,
672–673
materials to fit objects,
673–676, 674–675
size, 676–679, 677–679
brightness, contrast, and
strength, 411–413, 411, 413
clipping, 410–411, 412
exporting, 548–549, 548
frames for, 413–415, 413
importing, 406–408, 406–408
plotting, 259
quality, 413–415, 413
transparency, 415
visibility, 409–410
Bitmap OLE option, 554
BL text option, 310
Blipmode system variable, 37,
534–535
blips, 37, 937
Block Attribute Manager dialog box, 396–397, 397
Block Authoring palettes,
476–477, 476
Block Definition dialog box,
108–111, 108, 123, 123,
387–388, 885
Block Editor, 475–478, 476–478
Block Editor tool, 478
Block Editor toolbar, 476–477,
476–477
Block Units option, 111
blocks
adding and removing objects,
234–236, 235–236
annotation scale, 122–125,
123–125
for arrowheads and tick marks, 954–955, 955
from attribute definitions,
387–388
with attributes
adding, 382–385, 383–384
inserting, 388–390,
389–390
redefining, 397–398
dynamic. See dynamic blocks
editing, 475–478, 476–478
exploding, 118–119
Express Tools for, 747–748
vers. external references, 224,
227–228
with frozen layers, 205–206
inserting, 111–115, 112–113,
212–213, 388–390
layers for, 142–143
listing, 158–159
log files for, 159
as markers, 530
moving, 117, 117
names for, 120, 213, 236–237
nesting, 212
purging, 194–195, 195
redefining, 118–119
replacing, 120–121
saving, 120
scaling, 908
shapes for, 754–756, 755
with sheet sets, 876–882,
877–879
substituting, 213
with UCS, 606
unblocking, 118–119
updt, 212–213, 213
.BMP files. See bitmap images
Bold tool, 299
Boolean operations, 63,
703–705, 705
BORDER linetypes, 154
Borders
Tables, 328–329, 328–329, 336
Viewports, 460
Both Text and Arrows option, 948
Bottom Orthogonal views,
581, 582
Bottom UCS orientation, 598
Boundary command, 536–537
Boundary Creation dialog box,
537, 537
Boundary Set options, 219, 221
boundary windows, 290, 290,
297, 297
Box Mapping tool, 673
Box options for selecting, 48
Box tool, 563
Box, 703, 704
buildings from, 672–673,
672–673
creating, 563–564, 563
BR text option, 310
brackets ([ ] <>)
in calculator, 448
for default options, 39
for linetypes, 813–814
Break at Point tool, 29, 144, 144
Break Link option, 553
Break tool, 29, 516
breakat macro, 763–765, 764
breaking
keyboard macro for,
763–765, 764
lines, 144
objects, 184, 184
polyline, 516
vertices, 516, 516
brightness of raster images,
411–413, 411
Browse external reference
option, 230
Browse feature in DesignCenter
searches, 841
Browse The Web dialog box, 835
Browse The Web-Select
Hyperlink dialog box, 833
Browse To Another Sheet Set To
Use As An Example option, 867
Browse Pages option, 835
bump maps, 683, 683
Button Editor dialog box,
799–800, 799
Button Image group, 795, 795, 799
buttons
creating, 797–798, 797–798
icons for, 799–800, 799
By Object option, 655
ByBlock color assignment, 159
ByLayer color assignment,
159, 855
C
C command, 167
Cache Model Tab And All
Layouts option, 906
Cache Model Tab And Last
Layout option, 906
calculator. See QuickCalc
calculator
Calibrate Plotter wizard, 926, 926
calibration options, 926–927, 926
callout blocks, 867
creating, 887–888, 887–888
as cross-reference symbols,
872–874, 873
Camera Glyph setting, 685
Camera Preview dialog box,
687–688, 687
cameras
adjustments for, 687–689,
687–689
for view changes,
583–584, 584
for view control, 684–687,
685–687
Cancel option for OLE link
updating, 553
canceling commands, 33
capturing Text Window
information, 543
carets (^)
for calculator, 449
in menus, 801–802
Cartesian coordinates, 34–36,
35–36
cascading menus, 10
case sensitivity in AutoLISP, 773
Cell Border Properties dialog box,
328–330, 328
Cell Borders menu, 328
Cell Margin option, 327
Cell Styles settings, table
styles, 335
cells
array, 170–171, 171
table, 323, 323
formulas in, 330–331,
330–331
graphics for, 333, 333
text in, 324–325, 324–326
Celsscale system variable, 160
CENTER linetypes, 154
Center Mark tool, 366
center Mark tool, 366
center options
arcs, 39
gadients, 221
Onsnaps, 95, 385
text, 309
commas (,)
in Cartesian coordinates, 35
in hatch patterns, 815
in linetype patterns, 812
common base extension lines, 351–352, 352
Communication Center, 65–66, 65
Compare Dimension Styles dialog box, 942–943, 943
Compare option for dimensions, 942
comparison operators in filters, 432
complex linetypes, 813–815
complex objects, area of, 536–538, 536, 538
composite external references, 420–424, 420–424
composite solids, 705
concatenation, 771
Conceptual option, 587, 587
cones, 703, 704
Configure Standards dialog box, 850, 850
configuring, 896–897
3D graphics system, 917–919, 917
3D modeling, 911–912, 912
display options, 900–902, 900
drafting, 909–911, 909
DWF format files, 832
files, 897–900, 897
Grips feature, 916
interface settings, 905–907, 905
noun/verb selection method, 916
opening and saving, 902–904, 902
plotters, 258–259, 258
DWF format files, 831–832, 832
raster files, 548–549, 548
profile options, 914–915, 914
selections, 912–914, 912
tablet menu area, 915–916, 915
Tracking Vector, 916–917
user preferences, 907–909, 907
Confirm Purge dialog box, 195, 225
Constant attribute option, 387
Corner Deceleration option, 692
Constrained Orbit tool, 582–583, 582
constraining motion, 565–566, 565
Constraints panel, 372
Construction Line tool, 29, 187, 187
construction lines, 185–191, 185–186, 188–190
Containing option, 842
Containing Text option, 842
Content tab, 372
Content type option, 370
Context window, 316
Continue option, 351
continue dimensions, 350–351, 350
contour lines, 513–514, 513
Contour Lines Per Surface option, 711, 901
contrast of raster images, 411–413, 411, 413
control panels, 13, 13, 560–561, 561
control points, 526–528
corner elements, 692
control structures in AutoLISP, 780
If...Then...Else, 780–782
loops, 782–783
conventional memory, information on, 540
Convert Block To Xref tool, 748
Convert Object To Viewport tool, 466
Convert PLT to DWG tool, 757
Convert Shape To Block tool, 747
Convert To Block option, 110
Convert To Grayscale option, 279
Convert To Group Filter option, 152
Convert To Solid tool, 579, 579, 598, 602
Convert To Surface tool, 579
ConvertToCtb command, 286
converting
2D shapes to forms, 573–579, 573–579
3D drawings to 2D views, 259
3D views into 2D drawings, 590–592, 591–592
AutoLISP data types, 785–786
color plot styles to named plot styles, 286
layer settings, 853–855, 854–855
objects with thickness into solids, 578–579, 578–579, 602
polylines, 514–515
QuickCalc calculator for, 440–441, 441
surfaces to solids, 621
ConvertPtstyles command, 286
ConvertSolid command, 579, 602
cordinate data entry, priority for, 908
cordinate readouts, 8
drawing area size, 76
Polar Snap mode, 78–79
cordinates
AutoLISP, 774, 774
for distances, 32–36
hatch patterns, 816, 816
QuickCalc calculations, 447
spherical and cylindrical, 614, 615
Copy command, 543, 593
Copy Edges tool, 724, 724
Copy Faces tool, 724, 724
Copy History command, 543
Copy Link command, 555
Copy Nested Objects tool, 747
Copy Objects To New Layer tool, 746, 746
Copy Render Presets dialog box, 698
Copy Selected Sheets option, 830
Copy Tool, 29, 82, 82, 128
copying
attributes, 385–388, 385–386
circular, 166–168, 166–169
cases and edges, 725
with grips, 56, 56
lines, 82, 82
offsets for, 87–88
polylines, 510, 510
rows and columns, 169–173, 169–173
Text Window information, 543
cord length, 40
Corner Deceleration option, 692
corner styles, plot style tables for, 275–276

corners
chamfering, 718, 718
rounding, 716–717, 716
corrupted file recovery, 545, 935
cos function
AutoLISP, 772
calculator, 449
Count function, 331
CRC (Cyclic Redundancy Check) validation option, 903
cross-referenced drawings. See external references
Cross Section Only option, 637
cross sections with Loft, 637–639, 637, 639
crosshair cursor, 38, 902, 911
crosshair Labels option, 911
Crossing Polygon selection option, 48
Crossing Polygon windows, 359
Crossing selection option, 48
crossing windows, 48–52, 51–52, 358–359, 359
csv extension, 333
ctb files, 268, 286
Ctrl key in accelerator keys, 802
CUI (Custom User Interface), 791–794
Cuiload command, 804
cur function, 445
current layers, 143
current Viewport option, 219, 611
current viewports, 458
CurrentSheet options, 882
cursor, 8
cursor modes, 37–38, 38
curved 3D surfaces, 616–620, 617–620
curves
distances along, 191–192, 191–192
divisions on, 528–530, 529
extrusions on, 711–712, 711–712
NURBS, 81, 525
parallel, 510, 511
with Sketch, 531
spline. See spline curves
Curves tessellation option, 919
cus extension, 313
Custom option for shaded viewports, 248
Custom Paper Size wizard, 549, 927
custom properties, options for, 925
Custom Properties dialog box, 878–879
Custom setup option, 896
custom spelling dictionaries, 313

Custom tab
drawing information, 544
hatch patterns, 217
Custom User Interface (CUI), 791–794, 792–794
Customize dialog box, 847–848, 847
customizing AutoCAD. See also configuring
Command List for, 795
with Express Tools. See Express Tools
hatch patterns, 815–817, 815–817
linetypes, 810–815
macros, 800–802, 801–802
menus, 796–797
saving and loading customizations, 803–804, 804
sheet sets, 876–889, 877–879, 883–888
toolbars, 796–800, 798–799
user interface, 791–794, 792–794
workspaces, 789–791, 790
cuts, volumes of, 635–637, 635–637

cylinders, 703, 703–704
cylindrical coordinate format, 614, 615

d
d codes for degrees, 75, 311
d command, 339, 362
d2r function, 449
dal command, 363
Dan command, 365
dash-dot lines, 154
Dashboard, 7
for 3D drawings, 560–561, 561, 595, 596

working with, 13–14, 13–14
DASHDOT linetypes, 154
DASHED linetypes, 154
dashes (-). See minus signs (-)
Data Extraction Wizard, 399–403, 399–403
data types in AutoLISP, 769–770
databases, inserting, 550
Date and Time field, 880
Date Modified tab, 842
Date option for external references, 229
dates of external reference files, 229
Dba command, 351
dbConnect feature, 906
DC Online tab, 844
Dco command, 350
.dct extension, 313
Dctmain system variable, 313
Ddatte command, 539
Ddi command, 365
Decimal measurement system, 74
Decimal Places Of Accuracy option, 547
decimal points, 35, 72
Decimal Separator option, 341, 950
Decommand, 356, 368
Default drop-down list, 470
Default To Boundary Extents option, 210
defaults
attributes, 386
line weights, 470
plotting, 261, 928
Define Data Source dialog box, 399, 399
Define Window button, 203
defining attributes, 384–385
UCS, 596–599, 597–599
views, 203
definition points for dimensions, 354–356, 355
Defpoints layer, 356
defragmented hard disk space, 931
Defun function, 763–765, 764, 773, 775
Degate When Fps Is Below setting, 917
degrees and degree signs, 75, 311
Delete Columns option, 328
Delete Faces tool, 720, 720
Delete Interference Objects Created On Close option, 624, 636
Delete Layer button, 139, 139
Delete options
layer settings, 430
profiles, 914
Delete Output File option, 684
Delete Rows option, 328
Delete Style option, 280
deleting. See also erasing alternate dimensions, 362–363
attributes, 397
blocks, 194–195, 195
columns, 328
control points, 527
external reference objects, 234–236, 235–236
group object members, 132
hyperlinks, 835
layer settings, 430
layers, 139, 151
profiles, 914
rows, 328
scale list items, 247
sliced objects, 715
surfaces, 720
text styles, 295
tools, 793
DElta option, 193
Demand Load ObjectARX Applications option, 904
Demand Load Xrefs option, 904
demand loading, 230–231, 904
Description option blocks, 111
Form View tab, 279
Description tool, 839
descriptions
buttons, 798
groups of objects, 130–131
linetypes, 811
profiles, 914
Deselect Group option, 133
deselecting objects, 43
DesignCenter, 109, 836–839, 837–838
exchanging data between files with, 843
loading files into, 843–844
opening and inserting files with, 840
searching and extracting drawing contents with, 840–842, 840
for symbols, 844
for Tool Palettes, 844–848, 847
DesignCenter folder, 838, 838
DesignCenter window, 837–838, 838
desktop publishing
exporting raster files for, 548–549, 548
exporting vector files for, 550–551
Detach external reference option, 229
Details option
external reference, 229
groups, 133
Device And Document Settings tab, 923–924, 924
calibration, 926–927, 926
custom properties, 925
DWF format files, 832, 832
demand loading, 230–231, 904
description of, 925
initialization strings, 925
media, 924
merge control, 929, 930
paper sizes, 927, 927, 930
pens, 924–925
plotters, 258–259, 258
saving and importing, 928
device drivers, paths for, 898
Di command, 74
dialog boxes, 10
diameter dimensions, 365–367, 366
Diameter tool, 365
dictionaries
location, 898
spelling checker, 312–313
Diesel programming language, 804–805
at command line, 805–806
for menu option labels, 807–808
for menus, 806
for text, 809
Diffuse settings, 653
Diffuse map setting, 658–659, 658
Digital Signature Contents dialog box, 825, 825
Digital Signature tab, 825, 825, 827
digital signatures, 824–827, 825–827
digitizers, 406
digitizing tablets, 922
Dimadec dimension variable, 950
Dimalt dimension variable, 951, 954
Dimaltld dimension variable, 951, 954
Dimaltld dimension variable, 951, 954
Dimaltd dimension variable, 951, 954
Dimaltd dimension variable, 951, 954
Dimaltd dimension variable, 951, 954
Dimaltrnd dimension variable, 951
Dimaltd dimension variable, 953
Dimalt dimension variable, 952
Dimapost dimension variable, 952, 954
Dimarc command, 368
Dimassoc dimension variable, 936
Dimasz dimension variable, 945
Dimatfit dimension variable, 948
Dimaunit dimension variable, 950
Dimazin dimension variable, 950
Dimension Edit tool, 354–355
dimension lines, 337, 338, 943–945, 943–944
Dimension menu
  Align Text command, 358
  Aligned command, 363
  Angular command, 365
  Continue command, 350
  Dimension Break command, 373
  Dimension Space command, 353
  Dimension Style command, 362, 729
  Inspection command, 375
  Jogged command, 367
  Linear command, 349
  Multileader command, 369–370
  Oblique command, 368
  Override command, 360
  Quick Dimension command, 361
  Reassociate Dimensions command, 360
  Tolerance command, 375
  Update command, 358
  Dimension Style Manager dialog box, 339, 339
  alternate dimensions, 362
  current dimension style, 347
  editing dimension style, 347
  options, 940–943, 940
  for Paper Space, 473, 729–730
  Dimension toolbar, 348–349, 348
  Dimension Update tool, 358
dimensioned objects, editing, 358–359
  alternate, 362–363
  alternate units for, 346–346
  angles, 365–367, 365
  arrows for
    notes with, 369–372, 369
    styles for, 342–345, 343–344
  associative, 337, 360–361, 361
  colors for, 346
  components, 337–338, 338
  continuing, 350–351, 350
  definition points for, 354–356, 355
  distances between, 353, 353
  editing, 353–363
  Express Tools for, 756
  extension lines, 337–338, 338, 945
    common base, 351–352, 352
    settings for, 945
  Grips feature for, 354–357, 354–355
  horizontal and vertical, 349–350, 349
  leaders for, 357–358, 374
  metric, 954
  nonorthogonal objects, 363–368, 364–368
  notes for, 369–372, 369
  options, 909
  ordinate, 373–374, 374
  Osnap overrides with, 363
  in Paper Space, 471–473, 472, 729–730
  problems, 936
  radii, diameters, and arcs, 365–368, 365–368
  rotating, 364, 364
  scaling, 948–949
  skewing, 368, 368
  standards, 338
  string of, 361–362, 362
  styles. See Modify Dimension Style dialog box
  styles for, 338–348, 357–358, 756, 941, 946
  text for, 338, 338
  appending data to, 353–354
  height of, 341–342, 341
  location and orientation of, 342, 342
  moving, 357–358, 357
  options for, 946–947
  rotating, 358
  styles for, 357–358
  with UCS, 605
  units for, 340–341, 340
  Dimexe dimension variable, 945
  Dimexo dimension variable, 945
  Dimifit dimension variable, 360
  Dimfrac dimension variable, 949
  Dimgap dimension variable, 947, 953
  Diminspect command, 375
  Dimjust dimension variable, 947
  Dimldblk dimension variable, 945
  Dimldblk dimension variable, 945
  Dimldblk dimension variable, 945
  Dimlin dimension variable, 909
  Dimlin dimension variable, 950, 954
  Dimlin dimension variable, 953
  DimLine1 dimension variable, 945
  DimLine2 dimension variable, 945
  DimLine3 dimension variable, 945
  Dimlinear command, 348–349
  Dimlinear command, 348–349
  Dimlwd dimension variable, 943
Dimlwe dimension variable, 945
Dimoverride command, 360
Dimpost dimension variable, 950, 952
Dimreassociate command, 360
Dimregen command, 473
Dimrnd dimension variable, 950
Dimrotate command, 364
Dimscale dimension variable, 948–949
Dimsep dimension variable, 950
Dimsoxd dimension variable, 948
Dimtad dimension variable, 947
Dimtdec dimension variable, 953
Dimtfac dimension variable, 946, 953
Dimtih dimension variable, 947
Dimtx dimension variable, 367, 948
Dimtmove dimension variable, 948
Dimtfl dimension variable, 367, 949
Dimtoh dimension variable, 947
Dimt dimension variable, 947
Dimtp dimension variable, 953
Dimtmove dimension variable, 948
Display Alternate Units option, 346, 362, 951
display area, QuickCalc calculator for, 440–441, 441
Display At UCS Origin Point option, 603
Display Attribute Definitions for
Editing option, 237
Display Auto Track Tooltip option, 910
Display AutoSnap Aperture Box option, 92, 910
Display AutoSnap Tooltip option, 92, 910
Display Background Of Fields option, 908
Display Blocks Only option, 400
Display Blocks With Attributes Only option, 400
Display Cameras tool, 685, 685
Display Digital Signature Information option, 903
Display Drawing Status Bar option, 901
Display Full Path In Title option, 904
Display Full-Screen Tracking Vector option, 910
Display Layout And Model Tabs option, 455
Display Lineweight option, 273, 283, 329, 469
Display Locked setting, 462
Display OLE Text Size Dialog option, 906
display order with overlapping objects, 221–224, 222
Display Plot Styles option, 272, 283
Display Polar Tracking Vector option, 910
Display Screen Menu option, 901
Display Scroll Bars in Drawing Window option, 901
Display tab, 900–902, 900
cursor, 38
isolines, 711
Layout tabs, 257
plot preview background color, 930–931
scroll bars, 173
smoothness, 651
solid polylines, 510
Viewres, 156
Display UCS Icon option, 911
Display Viewports Dialog tool, 456
displays. See also screens information on, 540
options, 900–902, 900
resolution, 901, 921
Dist function, 445
Distance Between Two Points tool, 436, 437
Distance function, 783
Distance Light tool, 652
Distancelight command, 652
distances. See also dimensions
along arcs, 191–192, 191–192
between array cells, 171
coordinates for, 32–36, 34–36
between dimensions, 353, 353
in moving objects, 46
precision, 73
rubber banding for, 35
distant lights, 651–654, 651–654
Distribute tool, 299
Dither option, 279
Div command, 528
Divide command, 191
Divide function, 808
DIVIDE linetypes, 154
divided solids, separating, 725–726, 725
division
in AutoLISP, 771
in calculator, 449
in Diesel, 805, 808
in tables, 331
divisions on curves, 528–530, 529
Dl command, 349, 351
Do Not Display This Alert Again option, 476
docked toolbars, 15
Document field for sheet sets, 880
dollar signs ($)
in AutoLISP, 771
in calculator, 449
in Diesel, 805, 808
in importing files, 426
Don’t List Styles in Xrefs option, 941
donuts, 703, 704
door type symbols, 382, 382
Dor command, 374
DOT linetypes, 154
dotted windows, 51–52, 51–52
Double hatch pattern option, 207
double quotes ("), in AutoLISP, 770–771
in macros, 765
in units, 75
doughnuts, 703, 704
downloading symbols, 844
Dpl function, 445
Dpp function, 445
Dr command, 410
Draft Angles option, 639–640, 639
Draft mode, 413, 413
Draft option for shaded viewports, 248
Drafting Settings dialog box
  Grid Snap mode, 104
  grids, 103, 103
  Object Snap mode, 89, 89, 95, 100
  Polar Snap mode, 79, 80
  Polar Tracking, 185, 185
Drafting tab, 909–911, 909, 916–917
drafting tools
  grid mode as, 102–104
  snap mode as, 104
Draw Dim Line Between Ext Lines option, 949
Draw Frame Around Text option, 946
Draw menu
  3D Polyline command, 615
  Arc command, 89
  Block menu
    Base command, 173
    Define Attributes command, 384, 883–884
  Boundary command, 537
  Circle menu command, 568
  Construction Line command, 187
  Ellipse command, 81
  Hatch command, 535
  Modeling menu
    Extrude command, 575
    Loft command, 620, 622
    Sweep command, 626, 632
    Multiline command, 194
Point menu
  Divide command, 191, 528
  Measure command, 191, 530
Rectangle command, 11
Spline command, 515, 525
Table command, 324
Text menu
  Multiline Text command, 292
  Single Line Text command, 307
Draw Order feature, 217,
  221–224, 222
Draw toolbar, 791–793, 792–793
Draw True Silhouettes For Solids And Surfaces option, 902
drawing
  polylines, 507–509, 507–508
  spline curves, 525–526,
    525–526
  views, 726–729, 727–728
drawing area, 6–8
drawing limits, 75–78
drawing properties, associating with text, 319–323, 320–322
Drawing Properties dialog box, 544, 544
drawing sets, exchanging, 827–831, 828–831
Drawing Units dialog box, 72–75, 73, 954
Drawing Window Colors dialog box, 931
drawings. See also existing drawings
  creating, 28–32, 29, 32
  laying out, 88–94, 89–94
  linetypes for, 154–158,
    155–157
  locating objects, 81, 81
  managing. See DesignCenter modifying objects, 82–86
  planning, 86–87, 86
  publishing, 827–831, 828–831
  saving blocks as, 120
  tracing, 405–406
  zooming, 82
Drawings tab, 841–842
Draworder command, 224,
  410, 450
driver paths, 898
ds command, 104
dt command, 307
Dtext command, 308–309
DUCS button, 567, 567
Duplex Printing option, 924
Duration setting for animation, 692
DWF format files, 827–833
  adding to Web pages, 833
  configuring, 832
  creating, 831–832
  viewing, 830, 830
DWG Options tab, 547, 547
.DWS files, 849–850
DXF (data exchange format) files, 545–546
  exporting, 546–547, 546
  importing, 547–548
  problems in, 936
DXF Options tab, 546, 546
Dxfin command, 547
Dxout command, 547
DYN tool, 30, 30, 58, 58
dynamic blocks, 475
  actions for
    adding, 480–482, 481–482
    for arrays, 504–505, 504
    editing, 484
    scale and stretch, 486–490, 487–489
Block Editor, 475–478,
  476–478
centering, 485–486, 485
creating, 478–479, 478
filling space with objects, 504–505, 504–505
increment values for, 483–485,
  483–484
multiple shapes in blocks,
  497–501, 498–501
parameters, 479–480, 480
  attribute extraction, 494–497, 495–497
  editing, 484
  mirroring, 490–491, 490–491
  options for, 485
  scale and stretch actions for, 486–490, 487–488
  selectable lists, 492–494, 492–494
    sets for, 505
  rotating objects, 501–504,
    502–503
Dynamic input, 9–9, 30, 57–61,
  58–61, 911
Dynamic options for object length, 193
Dynamic Tessellation settings, 918–919
Dynamic UCS
labels in, 911
rotating objects, 566–568, 566–567
turning off, 577

E
E command, 87, 94, 515
E-mail Address option, 836
Edge Modifiers options, 589–590, 589
Edge Of Paper option, 249
Edge Surface tool, 616
Edge trim option, 85
edges
copying, 724
surfaces, 616–617
Edit Address dialog box, 396, 396
Edit Attribute Definition dialog box, 877–880, 877
Edit Block Definition dialog box, 476, 476, 478, 478
Edit Hyperlink dialog box, 835
Edit Image tool, 757
Edit Layer dialog box, 855, 855
Edit menu
Copy command
exporting, 555
spreadsheet data, 552, 554
tables, 332
text data, 543
copying faces and edges, 724
deleting surfaces, 720
extruding surfaces, 721–722, 723
moving surfaces, 719, 719
offsetting surfaces, 720, 720
rotating surfaces, 720, 721
rounding corners, 716–717, 716
separating divided solids, 725–726, 725
splitting solids, 715–716, 715
surface features, 724–725
tapering surfaces, 721, 722
turning solids into shells, 722–723, 723

plotter configurations, 258–259, 258
polylines, 510–522
solids, 571–572, 572–573, 714
chamfering corners, 718, 718
copying faces and edges, 724
deleting surfaces, 720
extruding surfaces, 721–722, 723
moving surfaces, 719, 719
offsetting surfaces, 720, 720
rotating surfaces, 720, 721
rounding corners, 716–717, 716
separating divided solids, 725–726, 725
splitting solids, 715–716, 715
surface features, 724–725
tapering surfaces, 721, 722
turning solids into shells, 722–723, 723

Effects for text, 296, 296
Either Text Or Arrows (Best Fit) option, 948
El command, 81, 87
elapsed timers, 541, 541
electronic plotting, 264
elements in AutoLISP, 769
elevations, information on, 540
Ellipse tool, 29, 81, 81
Ellipse Arc tool, 29
ellipses (...), 10
ellipses (shapes), 81, 81
embedding data, OLE for, 554–555
Emphasize Duplicate Tags option, 397
Enable Balloon Notification For New Announcement option, 66
Enable Dithering option, 279
Enable Fog option, 682–683
Enable Grips option, 913, 916
Enable Grips Tips Blocks option, 914
Enable Grips Within Blocks option, 914
Enable with Copy option, 899
Encapsulated PostScript (EPS) format, 550
End Angle setting, 640
End Cross Section option, 638
End grouping operator, 433
End Magnitude setting, 640
Endpoint Osnap overrides, 89–90, 95, 183, 183
endpoints
arcs, 40, 41
base points, 45, 46
Energy Multiplier setting, 697
Engineering measurement system, 73–74
Enhanced Attribute Editor dialog box, 391–393, 391–393
Enter Attributes dialog box, 389, 389
entities. See objects
Enu.dct file, 313
.eps files, 550
eq operator, 781, 808
equal operator, 781
equal signs (=)
in AutoLISP, 781
in Diesel, 808
in filters, 432
in tables, 331
Erase command, 22, 94
Erase tool, 22, 29, 459
Erase trim option, 86
erasing. See also deleting blips, 37
objects, 22, 23
layout lines, 94–95, 94
in Trim, 86
viewports, 459, 460
Esc (Escape) key, 33
eTransmit utility, 407
sharing files, 819–823, 820–821
sheet sets, 892
eval code, 808
excavations, volumes of, 635–637, 635–637
exchange data. See also
exporting; importing
with eTransmit, 819–823, 820–821
between files, 843
publishing drawings, 827–831, 828–831
exclamation points (!)
in AutoLISP, 768
in Diesel, 808
in filters, 432
existing drawings, 405
importing, 406–408. See also
raster images
in new drawings, 193, 194–195
sheet sets from, 858–866, 859–861, 863–864, 866
as symbols, 115–118, 116–117
tracing, 405–406
Existing Drawings option, 859
Existing File Or Web Page option, 836
Existing Set option, 219
Exit options
cameras, 687
multileaders, 370
exp function
in AutoLISP, 772
in calculator, 449
exp10 function, 449
Explode command, 118
Explode tool, 29, 118, 509
Explode Attributes To Text tool, 747
exploded blocks, 228
exploding
attribute blocks, 398
blocks, 118–119
groups of objects, 132
polylines, 509
exponentiation with calculator, 449
Export Attribute Information tool, 747–748
export command, 193
Export Data dialog box, 333
blocks, 120
stereolithography, 738
WMF files, 550
Export Data File dialog box, 193
Export options
layer settings, 430
profiles, 915
Export To A File option, 592
exporting
attribute information, 398–404
clipboard for, 555
dxf files, 546–547, 546
layer settings, 430
profiles, 915
raster files, 548–549, 548
tables, 333
vector files, 550–551
WMF files, 550
Express Block toolbar, 747
Express menu
Blocks command, 747, 756
File Tools menu, 756
Edit Image command, 757
Update Drawing Property Data command, 757
Layout Tools menu
Align Space command, 758
List Viewport Scale command, 760
Merge Layouts command, 760
Synchronize Viewports command, 759
Modify command, 752
Selection Tools menu
Fast Select command, 756
Get Selection Set command, 756
Text command, 747
Tools menu
Command Alias Editor command, 751
Make Linetype command, 753
Make Shape command, 754
Web Tools command, 758
Express Tools, 743
blocks, 747–748
layers, 744–746, 745
layout, 758–761, 759–760
loading, 745
menus for, 751–758, 751, 755
Standard toolbar for, 748–750
text, 746–747
toolbars for, 744, 744
expressions
AutoLISP, 767, 770–771
Diesel, 805
Expt function, 772
Ext command, 710
Ext Line 1 dimension variable, 945
Ext Line 2 dimension variable, 945
Extend Beyond Dim Lines option, 344, 344
Extend Beyond Ticks option, 344, 344
Extend To Nested Objects tool, 747
Extend tool, 29, 510
Extended Clip tool, 747, 752, 753
extending polylines, 510
extension lines, 337–338, 338
common base, 351–352
settings for, 945
Extension Osnap overrides, 95
Exts option
plot area, 244
zooming, 204
External Reference dialog box, 226, 226
DesignCenter, 840
insertion points, 420–421, 420
options, 230
search path, 426–427
External Reference tool, 421, 421
external references, 224, 417
adding and removing objects in, 234–236, 235–236
assembling, 420–424, 420–424
attaching drawings as, 225–227, 225–227, 840
vs. blocks, 227–228
clipping, 230–231, 231
editing, 227, 232–237, 232–236
vs. imported raster images, 407
importing from, 228, 425–426, 425–426
location, 422, 899–900
memory for, 230–232
nesting, 427
options, 229–230, 904
overlays, 427
paths for, 898
preparing drawings for, 418–420, 418–419
problems, 937
search paths, 426–427
with sheet sets, 872–874, 873
with symbols, 122
External References palette, 225, 225
exploding, 228
importing, 406, 406, 411
Open in, 227
options in, 229
extracting
attributes, 398–404, 494–497
495–497
drawing contents, 840–842, 840
Extrude tool, 575, 575
Extrude Faces tool, 721–722, 721
extruding
polylines
process, 573–578, 573–579
tapering in, 710–711,
710–711
in slicing solids, 634–635,
634–635
surfaces, 721–722, 723
extrusions
on curved paths, 711–712,
711–712
tapering, 710–711, 710–711
F
F command, 87
F1 function key, 64
F7 function key, 104
F8 function key, 80
F9 function key, 79
Face option, 620
faces
copying, 724
UCS, 620
Facetres system variable, 651
falloff of spotlights, 670–671,
670–671
Favorites folder, 838–839
Favorites tool, 837
feature control symbols, 374–376,
375–376
feet in units, 75
Fence/Crossing trim option, 86
Fenceline linetypes, 154, 813
fences for selections, 49, 49
Field dialog box
Diesel, 809
sheet sets, 877–879, 877, 879,
884, 884, 887, 888
text, 320, 321–322
Field Update Settings button, 908
fields
for associating text with
drawing properties, 319–323, 320–322
Diesel, 809
settings for, 908
sheet sets, 877–879, 877, 879,
884, 884, 887, 888
tables, 330–331, 330
text, 299
File Extension for Temporary Files option, 903
File Format option, 822
File menu
Close command, 16
Drawing Properties command, 544
Drawing Utilities menu
Purge command,
194–195, 225
Recover command, 935
for recovery tools, 545
eTransmit command, 820
Export command, 120,
194–195, 550
New command
3D Modeling, 559
template files, 5, 23
Open command
DXF files, 547
existing files, 17
exported files, 333
read-only files, 167
templates, 164
Page Setup Manager command, 258
Partial Load command, 933
Plot command, 240–241
Plot Manager command, 261
PlotStyle Manager command, 270, 273, 281
Plotter Manager command, 255, 549
Publish command, 827
Publish To Web command, 833
Save As command, 22, 164, 167, 546, 823
Save command, 22, 167
View Plot And Publish Details command, 829

File Name And Path option, 592
files
- corrupted, 545, 935
- exchanging data between, 843. See also exporting; importing
Express Tools for, 756–758, 759
- external references to. See external references inserting, 840
- loading into DesignCenter, 843–844
log, 159
- names for, 22, 30
- nesting, 174
- opening, 16–18
  - with DesignCenter, 840
  - multiple, 23–24, 24
  - with Sheet Set Manager, 862–863, 863
  - troubleshooting, 934–935
to views, 204
- options, 897–900, 897
paths, 228, 897–898
plotting, 239–243, 240–242
- protecting, 823–827, 824
- recovering, 935
- safety options, 903
- saving, 22
- searching for, 544–545, 545
- sheet sets for. See sheet sets and Sheet Set Manager tool swap, 931–932
  - as symbols, 115–118, 116–117
Files tab
- demand loading, 231
- external references, 422, 427
  - files, 897–900, 897
  - fonts, 314–315
- sheet sets, 860, 865
spelling dictionaries, 313, 314
templates, 164
Files Table tab, 820–821, 820, 890
Files Tree tab, 890
Fill Style option, 280
Fillet command, 180, 716
Fillet tool, 29, 96, 96, 180, 510, 717
filleting
- lines, 96, 97, 179–181, 180–181
- polylines, 510
- rounding corners with, 716–717
filling
- information on, 540
- multilines, 194
- solid areas, 522
- space with objects, 504–505, 504–505
Filter command, 431
Filter.nfl file, 432
filters
- criteria, 432–433
- layers, 148–153, 149–153
- objects, 430–433, 431
- paper size, 930
- point, 580, 581
- printers, 930
Final Gathering feature, 695–697, 696
Find And Replace dialog box, 316–317, 316
Find And Replace Options dialog box, 317, 317
Find And Replace URLs option, 758
Find command, 316
Find Name group option, 131
finding. See searching
Finish page, 257
First angle option, 370
First Set option, 624
Fit options
- dimension text, 358
- polylines, 513–514, 520
text, 310, 310
Fit Data option, 527–528
Fit tab
- dimensions, 345, 345
- options, 947–949, 947
Fit To Paper option, 240, 242, 245–246
Fit Tolerance option, 526
Fix function, 786
fixed UCS, 569
Flatshot command, 591
Flatshot dialog box, 727–729, 727
Flatshot tool, 590–592, 590, 727–728
Flip parameter, 490–491, 490
Float function, 786
floating viewports, 453
Fly tool, 584–585, 584
flyouts, 14, 14
.fmp extension, 314
fog, 682–683, 683
Fog Color option, 683
Folder Options dialog box, 919
folders, hidden, 919
Font drop-down list, 298, 298
Fontalt system variable, 315
Fontalt system variable, 315
fonts, 297–298, 298. See also text styles
- appearance, 305, 306
- AutoCAD window, 901
eTransmit, 822
linetypes, 814
problems, 937
substituting, 314–315, 315, 551
Foreach function, 783
Foreground Lines option, 592
Form View tab
- line corner styles, 275–276
- options, 278–280, 282–283
- plot styles, 270–271, 271, 273–274
Format menu
- Dimension Style command, 339
- Drawing Limits command, 30, 76
Layer command, 136, 147
Linetype command, 156–157, 471
Lineweight command, 272, 283, 329, 469
Point Style command, 191, 529
Rename command, 296
Table Style command, 334
Text Style command, 291
Units command, 73
Format option
exporting dxf files, 547
motion path animation, 692
formulas in tables, 330–332
Found At option, 229
Fraction Format option, 949
Fraction Height Scale option, 946
fractions
dimensions, 341
distances between points, 445, 444
units, 75–76
Frame Rate setting, 692
frames
dimension text, 946
raster images, 413–415, 413
Freeze layer option, 149
Freeze/Thaw icon, 146, 147, 204–205
freezing layers, 149, 204–206, 205, 463, 746
From Osnap option, 95, 182
Front Clip Plane grip, 688
Front Orthogonal views, 581, 582
Front UCS orientation, 598, 599
front views, drawing, 726–729
Full Path option, 230, 426
Full-Time CRC Validation option, 903
functions
AutoLISP, 770–772
Diesel, 805
QuickCalc calculator, 445
Grips feature, 50
3D drawings, 564–566, 564–565, 593
aligning objects, 98
text, 302
cameras, 688–689, 688
clipping images, 411, 412
copying objects, 56, 56
dimensions, 354–357, 354–355
dynamic block parameters, 490–497, 490–497
editing objects, 53–57
mirroring objects, 119
moving objects, 55–56, 56
multiple copies, 171
options, 913–914
problems, 935
rotating objects, 56, 56
scaling objects, 57
section planes, 735–736, 736
size of grips, 913
spline curves, 523–524, 524
stretching objects, 53–55, 54
summary, 57
turning on, 916
UCS, 600–601
Grips system variable, 916
Group command, 126
Group Manager, 127, 127, 132–133, 132
Group option for selections, 49
grouping operators, 432–433
groups of objects
creating, 125–127, 126–127, 131
identification options for, 130–132
layers, 151–152
modifying, 127–130, 128–129
Guides option, 634

G
g for grads, 75
Gap Tolerance option, 219
Gas line linetype, 154, 813
GB format, templates for, 164
Gcd function, 772
General panel, 371
General settings for table styles, 335
General tab
Drawing Properties, 544
Plot Style Table Editor, 277–278
Plotter Configuration Editor, 923
Generate 2D/3D Section command, 736
Generate Section/Elevation dialog box, 736, 736
Geographic Location dialog box, 650–651, 650–651
Geographic Location tool, 649, 649
Geometric Tolerance dialog box, 375, 375
generation, AutoLISP functions for, 783–784
Get A Digital ID option, 824
Get Coordinates tool, 436, 437
Get Selection Set tool, 756
Getangle function, 777–778, 778
GETAREA.LSP program, 762–763
Getcorner function, 777–778, 778
Getdist function, 777–778
Getint function, 777
Getkword function, 777
Getorient function, 777
Getpoint function, 772, 775, 777
Getreal function, 777
Getstring function, 777
Getvar function
Diesel, 805–806, 808–809
QuickCalc calculator, 445
Grayscale option, 279
3D drawings, 564–566, 564–565, 593
aligning objects, 98
text, 302
cameras, 688–689, 688
clipping images, 411, 412
copying objects, 56, 56
dimensions, 354–357, 354–355
dynamic block parameters, 490–497, 490–497
editing objects, 53–57
mirroring objects, 119
moving objects, 55–56, 56
multiple copies, 171
options, 913–914
problems, 935
rotating objects, 56, 56
scaling objects, 57
section planes, 735–736, 736
size of grips, 913
spline curves, 523–524, 524
stretching objects, 53–55, 54
summary, 57
turning on, 916
UCS, 600–601
Grips system variable, 916
Group command, 126
Group Manager, 127, 127, 132–133, 132
Group option for selections, 49
grouping operators, 432–433
groups of objects
creating, 125–127, 126–127, 131
identification options for, 130–132
layers, 151–152
modifying, 127–130, 128–129
Guides option, 634

H
Halfwidth polyline option, 509, 510
hard clip limits, 263, 263
hard disk drives, 540, 931–932
Hardware And Performance
Tuning Group settings, 917

Hatch And Gradient dialog box
adding hatches, 207–208, 207 gradients, 220–221, 220
More Options, 218–219, 218
object area, 535–536
options, 216–217
position, 209–210, 209
tips, 221
Hatch Edit dialog box, 214–215
Hatch Pattern Palette dialog box, 209, 209, 215–217
hatch patterns, 206
additional features, 218–219
for area of objects, 535–536, 536
creating, 815–817, 815–817
Express Tools for, 748–750, 749–750
for gradients, 219–221, 220
layers for, 206
matching, 223
modifying, 214–216, 215–216
placing, 206–208, 207
position, 208–212, 209–211
predefined, 210–211, 211
size, 214
and space planning, 221–224, 222
standard, 815
tips, 221
for Tool Palettes, 846–847
Hatch tool, 29, 207
height
cameras, 687
dimension text, 341–342, 946
shapes, 755
text, 296–298, 298, 384
Height option, 687
helicoids, 631–632, 632
Helix tool, 630, 630
help
for commands, 62–66, 62–63, 65
Communication Center, 65–66, 65
context-sensitive, 64
in DesignCenter searches, 841
Diesel, 807–808
digitizers, 406
groups, 133
InfoCenter for, 62–64, 62–63
sources, 64
Help dialog box, 807
Help feature in DesignCenter, 841
help files, location of, 898
Help menu
Additional Resources menu, 787
Help command, 62
New Features Workshop command, 4
hexagons, dimensioning, 365–367, 365–367
Hidden Files And Folders option, 919
hidden folders, 919
hidden lines, 708
HIDDEN linetypes, 154
Hidden option
plotting, 248
spheres, 587, 587
Hide command, 250, 708
Hide Layout And Model Tabs option, 455
Hide System Printers option, 262, 930
hiding
by masking, 465
in plotting, 250
Highlight options for groups, 130
Highlight Interference option, 625
Highlight Interfering Pair option, 625
Highlight Raster Image Frame Only option, 902
highlighting selected objects, 43, 43
history
commands, 66, 66
recent files, 844
History tab, 844
History List tab, 762–763
Home dimension text option, 355
Hor Xline option, 190
Horizontal Cell Margin option, 327
horizontal dimensions, 349–350, 349, 947
horizontal lines, 31
horizontal Xlines, 190
hot grips, 53, 54, 56
Hot_water_supply linetype, 154
hotspots of spotlights, 671, 671
How To Apply option, 435
HPGL plot files, 551
Hyperlink icon, missing, 937
Hyperlink menu
Edit Hyperlink command, 835
Open command, 835
Hyperlink option, 111
hyperlinks, 833, 836
creating, 833–835, 834
editing and deleting, 835
options, 835–836, 909
hyphens (-)
in AutoLISP, 771
with calculator, 449
in Diesel, 808
in linetype patterns, 812
for macros, 798
with tables, 331
in units, 75

I
i-drop, file location for, 900
iad command, 411
iat command, 407
Id command, 411
icons
creating, 799–800, 799
UCS, 8–9, 457, 596, 603–604
ID command, 533
.ies extension, 900
if code in Diesel, 808
If...Then...Else structures in AutoLISP, 780–782
Ignore options
hatch pattern island detection style, 218
spelling checker, 313
Ignore All option, 313
Ignore Top Level Folder option, 862
Ignored Problems option, 853
Ill function, 445
Ilp function, 445
Image dialog box, 407–408
Image Adjust dialog box, 411–413, 411
Image Entity OLE option, 555
image files. See bitmap images
Image Manager dialog box, 411
Imageclip command, 411
Imageframe command, 413
Imperial measurement system, 72
Implied Windowing option, 913
Import Attribute Information tool, 748
Import options
layer settings, 430
profiles, 915
Sheet Set Manager, 862
Import Options dialog box, 860, 862
Import PCP Or PC2 page, 256
importing
dxf files, 547–548
external references, 228, 425–426, 425–426
layer settings, 430
plotting options for, 928
profiles, 915
raster images, 406–408, 406–408
settings, 174–176, 175–176
spreadsheets, 553–554, 553
tables, 322–333, 332
text files, 306–307
Imprint tool, 724, 724
In feature in searches, 841
in-place external reference editing, 232–237, 232–236
In The Field(s) option, 841
Inch setting, 246
inches, 75
Include Files From Data Links option, 822
Include Fonts option, 822
Include Layouts When Adding Sheets option, 830
Include Model When Adding Sheets option, 830
Include Photometric Web Files option, 822
Include Plot Stamp dialog box, 829, 829, 892
Include Textures from Materials option, 822
Include Unnamed group option, 130–131
increment values for dynamic blocks, 483–485, 483–484
Incremental Save setting, 933
Incremental Save Percentage setting, 903
indents for text, 302–305, 302–305
Index Color tab, 138, 138
Indextl system variable, 933
indexes, Spatial and Layer, 933
Indicate Layers In Use option, 152
Info Center Settings dialog box, 65, 65
InfoCenter for help, 62–64, 62–63
information
area, 533–538, 534
block and layer status, 158
saving, 542–543
Status for, 539–540, 539
storing, 543–544, 544
system variables, 541–542
from Text Window, 543
time, 541, 541
Inherit Properties option, 217, 219
Initget function, 777
initialization strings, 925
input
AutoLISP, 775–778, 778
dynamic, 30, 57–61, 58–61
with menus, 801–802, 801
Insert A Block In A Table Cell dialog box, 333, 333
Insert As Block option, 840
Insert As New Block option, 591, 728–729
Insert Block tool, 29
attributes, 388
browsing, 175, 181
symbols, 112, 112, 115
updating blocks, 212, 423
Insert Columns option, 328
Insert dialog box, 423, 840
browsing in, 175, 724
with layers, 145
for symbols, 112, 112, 115
Insert Field tool, 299
Insert Hyperlink dialog box, 833–836, 834
Insert menu
Block command, 333, 724
External References command, 225–226, 406–408
Hyperlink command, 758, 833
Layout command, 455
OLE Object command, 552
Raster Image Reference command, 407
Insert Object dialog box, 552, 552
Insert Osnap option, 95
Insert Table dialog box, 324, 324
Inserted Links option, 835
inserting
base points for, 158
blocks, 111–115, 112–113
with attributes, 388–390, 389–390
in updating, 212–213
columns, 328
files, 115–118, 116–117, 840
objects, 181–184, 183–184
rows, 328
spreadsheets, 551–555, 551–554
symbols, 111–115, 112–113
vertices, 517, 517
Insertion Scale setting, 75
Inside Borders option, 330
Inspection Dimension dialog box, 375–376, 375
Installation wizard, 896
installing AutoCAD, 895–896
Insunits system variable, 75
Integers in AutoLISP, 769
Intensity Factor setting, 654
interface settings, 905–907, 905
interference command, 623
interference
with primitives, 705
between solids, 622–625, 623–625
Interference Checking dialog box, 623–625, 623
Interference Checking tool, 623, 636, 636
Interference Settings dialog box, 625, 625
Interfering Pairs Found option, 624
interior views, rendering, 695–697, 695–696
Internet. See exchanging data;
World Wide Web (WWW) sites
interpreter, AutoLISP, 767–768
Invert function, 778
Intersection Of Two Lines Defined By Two Points tool, 436, 437
Intersection Osnap option, 45, 46, 89–90, 95
intersections
  for base points, 45, 46
  primitives, 704, 705
Invert Filter option, 152
invisible attributes, 387, 394–395
Island Detection, styles for, 218
ISO format and standards dimensions, 947
  templates for, 164
ISO-25 style, 339
ISO standard option, 947
isolines, 711
Isolines system variable, 711
isometric views, 581–582, 582
Italic tool, 299
Itoa function, 785
J
  J command, 309
JIS format, 164
Jitter Edges tool, 590, 590
Jogged tool, 367
jogs in section planes, 734, 735
Join tool, 29
joining
  lines, 96, 97, 179–181, 180–182
  polylines, 511–512, 511
  primitives, 706–708, 706–708
  strings, 771
Jointype option, 511
justification of text, 301–302, 301, 309–310, 309–310
Justify tool, 299
Justifytext command, 302, 310
K
  Keep Dim Line With Text option, 357
  Keep Files And Folders As Is option, 822
  Keep The Layout Paper Size If Possible option, 261
  Keyboard Entry option, 908
  Keyboard Entry Except Scripts option, 908
  keyboard macros, 763–765, 764
  keyboard shortcuts, 10, 87
  Command Alias Editor for, 751–752, 751
  on menus, 802–803, 803
  settings, 907
  troubleshooting, 936
  keyboard vs. menus, 15–16
  Keycad.LSP file, 765, 765
  keywords, storing, 544
L
  L command, 87
  Label Axes In Standard Crosshairs option, 911
  labels. See also text
  Diesel for, 807–808
  for parameters, 484
  Lamp Intensity dialog box, 700, 700
  Landing Settings panel, 372
  landscape, 679–682, 680–682
  landscape orientation, 243–244
  last objects, selecting, 49
  Last option in selecting, 49
  Layer & Spatial option, 233
  Layer color icon, 146, 147
  Layer command, 139–140, 143
  Layer Control dialog box, 425
  Layer Filter Properties dialog box, 148–150, 149
  Layer Freeze tool, 746, 746
  Layer Isolate tool, 746, 746
  Layer Lock tool, 746, 746
  Layer Match tool, 745–746, 746
  Layer name icon, 146, 147
  Layer Off tool, 746, 746
  Layer option for demand loading, 233
  Layer Previous tool, 430
  Layer Properties Manager dialog box, 136–141, 137
  external references, 425–426
  filters, 148
  finding layers, 147–148
  freezing and thawing layers, 149, 204–206, 205
  layer groups, 151–152, 151
  line weight, 468–469
  linetypes, 154–155
  listing layers, 158
  locking and unlocking layers, 149
  plot style table, 285–286
  saving settings, 428–429
links
  editing, 552–553
  hyperlinks. See hyperlinks
  spreadsheets, 551–553
  Links dialog box, 552–553, 552
  LISP. See AutoLISP program
  List function, 776
  List Object Xdata tool, 756
  List option for dimensions, 941
  List tool, 66
  List Xref/Block Properties tool, 747
  listing layers, 158–159
  listp operator, 781
  lists
    AutoLISP, 769, 775–776
    selectable, 492–494, 492–494
  Live Enabler, 906–907
  Live Section feature, 732
  ln function, 449
  Load Acad.lsp With Every Drawing option, 906
  Load function, 787
  Load Or Reload Linetypes dialog box, 155, 155
  Load Partial Customization File tool, 804
  Load tool, 843
  Load Sheet List tool, 829, 829
  Load/Unload Applications dialog box, 761–763, 761, 786
  Load/Unload Customizations dialog box, 804
  loading
    AutoLISP programs, 761–763, 761
    customizations, 803–804, 804
    Express Tools, 745
    files into DesignCenter, 843–844
    layer mappings, 855
    linetypes, 155
  local variables in AutoLISP, 780
  locating. See searching
  location
    cameras, 687
    filtering objects by, 432
    hatch patterns, 208–212, 209–211
    objects, 81, 81
    for plotting, 249, 249
    table text, 326–328, 326–328
  Location option, 687
  Lock layer option, 149
  Lock Objects Not in Working Set option, 237
  Lock option, 387
  Lock/Unlock icon, 146, 147
  locking
    layers, 149, 746
    viewports, 462, 462
  Loft command, 637, 638
  Loft Settings dialog box, 622, 622, 637, 637
    Close Surface and Close Solid options, 640
    Draft Angles option, 639–640, 639
    Normal To option, 638, 639
    Ruled and Smooth Fit options, 638, 638
    surfaces, 633–634, 633
  Loft tool, 620, 622, 632–633
  Log File Location option, 542
  log functions
    AutoLISP, 772
    calculator, 449
    Logfilemode command, 159
    Logfilename system variable, 542
    Logfileoff command, 542
    Logfileon command, 542
  logical operators
    AutoLISP, 780–782
    grouping, 433
    help searches, 63
  logs
    for blocks and layers, 159
    options, 903
    plot, 262
    for system information, 542–543
  long lines in menus, 802
  Long String Editor, 802, 802
  Look For Options feature, 841
  Lookup Action, 492–493, 492
  Lookup parameter, 492–493, 492
  loop structures in AutoLISP, 782–783
  Lower Value option, 953
  Lowercase tool, 299
  .lsp extension, 765, 786
  Ltscale command, 156
  Ltscale system variable, 156–157
  Ltype Gen option, 513
  Luminance setting, 655, 663
  lunits command, 73
  Luprec system variable, 74
  Lwdisplay system variable, 470

M
M command, 87
macros
  AutoLISP, 763–765, 764
    for buttons, 798
  Diesel for, 804–809
  text boxes for, 801–802, 802
    in tools and menus, 800, 800
  Magnet option, 92, 910
  Maintain A Log File option, 542, 903
  Maintain Visual Fidelity For Annotative Objects option, 903
  Make Block tool, 29, 108, 885
  Make Invisible tool, 500, 500
  Make Linetype tool, 752–754, 753
  Make New Dimensions
    Associative option, 471, 909
  Make Render Settings Current option, 684
  Manage Cell Style dialog box, 336
  Manage Page Setups option, 892
  Manager Render Presets command, 697
  managing drawings. See DesignCenter
  manual OLE link updating, 553
  Manual Performance Tuning dialog box, 918–919, 918
  Map Same button, 854
  marble, procedural maps for, 662–663
  margins
    Layout tabs, 252, 252
    table cells, 327
    table styles, 335
  Marker option, 910
  markers
    with AutoSnap, 92, 910
    blocks as, 530
    on curves, 528–530, 529
  masking
    drawing parts, 465
    text backgrounds, 746
  mass of solids, 726
  massing models, 408
Massprop command, 726
Master Setup dialog box, 896
Match Block Orientation To Layout option
blocks, 110
symbols, 123
Match Properties tool, 223
matching hatch patterns, 223
Material Attachment Option dialog box, 664, 664
Material Condition dialog box, 375, 375
Materialmap command, 673–674
materials
adjusting to fit objects, 673–674
assigning by layer, 664–665
bitmap size for, 676–679
creating, 656–659
global, 654–656
opacity maps for, 679–682
procedural maps for, 663–664
self-illuminated, 662–663
Materials palette, 655, 655
Materials panel, 561, 561, 654
Materials tool, 654
math operations
AutoLISP, 772
QuickCalc. See QuickCalc calculator
tables, 331–332
Max function, 771
Maximum option for shaded viewports, 248
Maximum Number Of Unsuccessful Checks option, 907
Maxpoints option, 370
MC text option, 310
Me command, 530
Measure command, 191
measurement systems. See units measurements
with coordinate readout, 79
curves, 528–530
media, options for, 924
Media Bounds page, 549
Media Destination option, 924
Media Type option, 924
memory
in AutoLISP, 780
for external references, 230–232
information on, 540
and performance, 931–933
menu bars, 6
menu files, location of, 898
menus, 7–11
context-sensitive, 12
creating, 796–797
Diesel in, 806
for Express Tools, 751–758
vs. keyboard, 15–16
long lines in, 802
macros in, 800, 800
for publishing drawings, 829–830
right-click, 40–42
shortcuts on, 802–803
Merge Cells menu, All command, 325
Merge Cells On Row/Column Creation option, 335
merge control for plotters, 929, 930
merging
cells, 325
viewports, 760–761
messages in Command window, 8
Method option, 953
metric dimensions, 74, 954
metric measurement system, 72
Middle text option, 309
Midpoint Osnap option, 89–90
Min function, 771
minus signs (-)
in AutoLISP, 771
with calculator, 449
in Diesel, 808
in linetype patterns, 812
for macros, 798
with tables, 331
in units, 75
minusp operator, 781
Mirror command, 57, 359, 593
Mirror tool, 29, 93, 93
mirroring
3D objects, 593
3Dmirror for, 644
dynamic block parameters for, 490–491
and exploding, 120
group members, 128–129, 129
objects, 93, 93, 120
text, 310–311, 311
with UCS, 618, 619
Mirttext system variable, 310–311
missing fonts, substitutions for, 314–315
mistakes, correcting, 33
MKLTYPE dialog box, 753–754
MKSHAPE dialog box, 754
ML text option, 310
Mld command, 369
mleaderstyle command, 370
Mledit command, 194
Mline command, 194
Mstyle command, 194
Model Space
entering, 459
information on, 540
vs. Paper Space, 453–454
Model Space tab, 827
Model Views tab, 864, 870
models. See 3D drawings
and models
Modemacro system variable, 805–806
Modify Archive Setup dialog box, 890–891
Modify Dimension Setup dialog box, 347, 358
Alternate Units tab, 951–952
Fit tab, 947–949
Lines tab, 943–945, 943–944
for Paper Space, 729–730
Primary Units tab, 949–950
Text tab, 946–947
Tolerances tab, 952–953
Modify menu
3D Operations menu
3D Move command, 642
3D Rotate command, 643, 713
3Darray command, 644
3Dmirror command, 644
Align command, 640
Convert To Solid command, 602
Interference command, 623
Thicken command, 621
Clip menu
Image command, 411, 752
Viewport command, 466
Xref command, 230, 752
Copy command, 82
Erase command, 22
Fillet command, 96
Lengthen command, 192
Move command, 117
Object menu
Attribute menu, Block command, 395
Attribute menu, Global command, 393
Attribute menu, Single command, 391
Image menu, Adjust command, 411
Image menu, Frame command, 413
Image menu, Quality command, 413
Image menu, Transparency command, 415
Polyline command, 511, 514–515
Spline command, 515, 527
Text menu, Edit command, 354, 484
Text menu, Justify command, 302, 310
Offset command, 87, 510
Region command, 708
Rotate command, 567
Solid Editing menu
Subtract command, 707
Union command, 707–708
Modify Multileader Style dialog box, 371–372, 371
Modify option for dimensions, 942
Modify Standard Paper Size wizard, 927
Modify Table Style dialog box, 335
Modify Transmittal Setup dialog box, 821–822, 821
modifying, See editing monitors, display, 921
motion, constraining, 565–566, 565
motion path animation, 690–692, 690
Motion Path Animation dialog box, 690–691, 690
mouse, 922
Move Backup Files tool, 757
Move Down option, 397
Move Faces tool, 719, 719
Move Sheet Up tool, 829, 829
Move Text, Add Leader option, 357–358
Move Text, No Leader option, 358
Move tool, 29, 43, 50, 117, 593
Move UCS tool, 620
Move Up option, 397
moving arcs, 50 blocks, 117, 117
Command window, 7
dimension text, 342, 342,
357–358, 357
with grips, 55–56
objects, 46–48, 47, 642, 642
surfaces, 719, 719
in UCS, 600–601, 600–601,
606–607
vertices, 517–518, 518
viewports, 459, 460
MR text option, 310
MS command, 457
Mtext Justification tool, 299
Mtext option, 374
Multi-Sheet option, 831
Multileader Align tool, 373
Multileader Collect tool, 373
Multileader Edit tool, 373
Multileader Style Manager dialog box, 370, 371
Multileader tool, 369–370, 369
Multileader Style tool, 370
multileaders, 369–370, 369
editing, 372–373
styles, 370–372, 371
Multiline Text Editor, 292–293,
293, 355
Multiline Text tool, 29, 292, 292,
297–298
multilines, drawing, 194
multiple copies circular, 166–168, 167–169
row and column, 169–173,
169–173
multiple dimensions, editing, 355
multiple drawings, standards for, 851–853, 851–852
multiple files, opening, 23–24, 24
multiple layers, converting settings for, 853–855, 854–855
Multiple Lines option, 387
multiple Paper Space layouts, 465–466
multiple plot style tables, editing, 273–275, 274–275
Multiple selection option, 49
multiple shapes in blocks, 497–501, 498–501
Multiple Viewports tool, 652, 652
multiple views, 201
multiplication
AutoLISP, 771
calculator, 449
Diesel, 808
tables, 331
Multiplier for Alt Units option, 951
Multiply function, 808
Mview command, 468
My Computer option, 256

N
Name option, 687
named elements, importing, 228, 425–426, 425–426
named plot styles converting color plot styles to, 286
layers and objects, 280–283, 280–282
tables for, 267–270
Named UCSs tab, 599
Named Viewports tab, 610
Named Views tab, 609

- **blocks**, 109, 112, 120, 213, 236–237
- **buttons**, 798
- **cameras**, 687
- **color plot style tables**, 270
- **external references**, 229
- **files**, 22, 30
- **groups of objects**, 127, 130–131
- **layers**, 137, 152–153, 153, 236–237, 848–849
- **layouts**, 830
- **linetypes**, 811
- **page setups**, 260
- **profiles**, 914
- **table styles**, 334
- **text styles**, 291, 295–296
- **UCS**, 599–600
- **views**, 203
- **natural light**, 694

**NEAR operations**, 63
**Nearest Osnap option**, 96
**Neest option**

- **AutoLISP expressions**, 770
- **blocks**, 195, 212
- **external references**, 427
- **files**, 174

**Network Plotter Server option**, 256
**New button for views**, 202
**New Command Alias dialog box**, 751, 751
**New Dimension Style dialog box**, 340, 340
  - **Alternate Units tab**, 346, 346
  - **Fit tab**, 344–345, 345
  - for previewing, 942
  - **Primary Units tab**, 340–341, 340
  - **Symbols And Arrows tab**, 342–345, 343
  - **Text tab**, 341–342, 341
**New Dimensions Associative option**, 729
**new drawings**, 28–32, 29, 32
**New Features Workshop**, 4, 64
**New Group Filter tool**, 148, 151
**New Layer button**, 139, 139

**New Layer dialog box**, 855, 855
**New Layer State To Save dialog box**, 428, 428
**New Layer VP Frozen In All Viewports tool**, 139, 139
**New options**
  - **boundary sets**, 219
dimensions, 941
  - **groups**, 131
  - **layer settings**, 430
  - **layers**, 140
text styles, 295
**New Or Modify Dimension Style dialog box**, 369
**New Property Filter tool**, 148–149
**New Search feature**, 841
**New Sheet dialog box**, 866, 866, 870, 877
**New Sheet Set option**, 859, 867
**New Style Name option**, 941
**New Table Style dialog box**, 334–336
**New Text Style dialog box**, 291
**New Tool Palette command**, 845
**New View command**, 665
**New View dialog box**
  - background, 660, 660
categories, 202–203, 202
  - **spotlights**, 666, 666
title blocks, 868–870
**UCS**, 599–600
**views**, 203
**northern Hemisphere**, 638

**Normal option for shaded viewports**, 248
**Normal To option**, 638, 639
**North Direction setting**, 650–651, 650
**Northeast Isometric view**, 581, 582
**Northwest Isometric view**, 581, 582
- **not equal to operator**, 432
- **not operator**
  - **AutoLISP**, 782
  - **searches**, 63
**notes**
  - **arrows and dimensions**, 369–372, 369
  - **multileader**, 372–373
  - **Paper Space**, 729–730
  - **noun/verb selection method**, 48, 50, 52, 913, 916
**Nth function**, 775–776
**nul operator**, 782
**Number Of Frames setting**, 692
**Number Of Recently-Used Files To List option**, 904
**Number Of Tessellations To Cache option**, 919
**Numbering tool**, 299
**numberrp operator**, 781
**NURBS curves**, 81, 525

**O**
- **o codes for characters**, 311
**O command**, 87
**object enablers**, 906–907
**Object Grouping dialog box**, 126–127, 126, 130–132, 130
**Object Grouping option**, 913
**Object Linking and Embedding (OLE)**, 551–552, 551
  - **editing links in**, 552–553, 552
  - **for embedding data**, 554–555
**Object Selection cursor**, 38, 38
**Object Selection Filters dialog box**, 431, 431
**Object Selection Limit For Display Of Grips setting**, 914
**Object Selection mode**, 43
**Object Snap tab**, 87
**Object Snap Tracking**, 43
**Object Snap Tracking and overrides**
  - **Object Type option**, 435
OBJECT TYPES FOR QUICK SELECT • OPTIONS DIALOG BOX

objects

- aligning in 3D space, 640–642, 641
- with layout objects, 758–759, 759
- with Osnap tracking, 97–102, 98–102
- area of, 534–535, 534
- complex, 536–538, 536, 538
- hatch patterns for, 535–536, 536
- attaching data to, 756
- blocked. See blocks
- breaking, 144, 184, 184
- centering, 485–486, 485
- colors, 159
- converting, 514–515
- copying. See copying
deselecting, 43
- editing, 53–57, 82–86, 358–359, 359
- erasing and deleting, 22, 23
- layout lines, 94–95, 94
- in Trim, 86
- filleting, 96, 97
- groups, 125–133, 126, 128–129
- inserting, 181–184, 183–184
- layers for, 140–142, 745–746
- length of, 192–193
- linetypes for, 159
- locating, 81, 81
- mirroring, 93, 93, 120
- moving, 46–48, 47, 55–56, 642, 642
- nonorthogonal, dimensions for, 363–368, 364–368
- number of, 540
- overlapping. See overlapping objects
- plot styles for assigning, 283–285, 284–285
- named, 280–283, 280–282
- properties for, 67–68, 67
- rotating. See rotating
- selecting, 22, 42–44, 43–44
- base points for, 44–48, 46–47
- for blocks, 108–109
- close and overlapping, 450
- filters, 430–433, 431
- noun/verb method, 48, 50, 52, 913, 916
- options, 48–50, 912–914
- problems, 935
- Quick Select, 434–435, 434
- stretching, 53–55, 54
- trimming, 82–86, 83–85
- Objects field for sheet sets, 880
- Objectscale command, 294
- oblique angle
dimension text, 355
text, 296, 296
- Oblique Angle tool, 300
- oblique dimension lines, 368
- Oblique options, 355
- Obscured Lines option, 592
- odd-shaped viewports, 466–468, 466
- office standards, 848–853
- Offset Faces tool, 720
- Offset From Dim Line option, 342, 342, 947
- Offset From Origin option, 344, 344
- Offset tool, 29, 87–88, 87, 510
- offsets, 184, 184
- 3D surfaces, 568
dimensions, 338, 338
- extension lines, 945
- plotting, 249, 249
- polylines, 510, 510–511
- problems with, 937
- reference lines, 87–88
- surfaces, 720, 720
- UCS orientation, 606, 606
- Xlines, 187, 188, 190
- OLE (Object Linking and Embedding), 551–552, 551
- editing links in, 552–553, 552
- for embedding data, 554–555
- OLE objects, 307
- OLE Plot Quality list, 261
- OLE setting, 925
- Olequality system variable, 261
- Olestartup system variable, 262
- On/Off layer option, 146, 147
- One Color option, 220
- Online Development Center, 64
- opacity maps, 679–682, 680–682
- Opacity setting, 658–659
- Open And Save tab
- exporting dxf files, 547
- external references, 227, 904
- file safety, 903
- incremental saves, 933
- log files, 542
- memory, 230
- ObjectARX applications, 904–905
- options, 902–904, 902
- passwords, 823
- saving, 902–904
- Open Drawings tab, 843
- Open in Block Editor option, 111
- Open option
- external references, 229
- polylines, 512
- Open Sheet Set dialog box, 873
- Open Source OLE option, 553
- Open Tables in Read-Only Mode option, 906
- Open tool, 853
- opening
- exported files, 333
- files, 16–18
- with DesignCenter, 840
- multiple, 23–24, 24
- in Sheet Set Manager, 862–863, 863
- troubleshooting, 934–935
to views, 204
- options, 902–904, 902
- Operator option, 435
- operators in Diesel, 805
- optimizing hard disks, 931
- options, choosing, 38–42, 40–42
- Options dialog box
- associative dimensions, 471, 729
- cursor, 38
- demand loading, 231–232
display, 900–902, 900
drafting, 909–911, 909
- external references, 227, 422, 427
- files, 897–900, 897
- fonts, 314–315
grips, 916
incremental saves, 933
interface settings,
    905–907, 905
isolines, 711
Layout tabs, 257
line weights, 273
log files, 542
memory, 230
named plot styles, 281, 283
offsets, 249
opening and saving,
    902–904, 902
output devices, 256
passwords, 823
plot preview background
color, 930
plot style tables, 268
plotting,
    261–262
pointing devices, 922
printer filters,
    930
profiles,
    914–915, 914
Publish, 264
saving files, 22
scale lists, 247
scroll bars, 173
selections,
    912–914, 912
, 916
sheet sets, 860, 865
smoothness, 651
solid polylines, 510
spelling dictionaries, 313, 314
templates, 164
Text Window, 543
Tracking Vector, 916–917
user preferences,
    907–909, 907
Viewers, 156
Or command, 373
OR operations
    AutoLISP, 782
    grouping, 433
    searches, 63
ordering objects, 131
Ordinate Dimension tool, 374
ordinate dimensions,
    373–374, 374
orientation
dimension text, 342
paper, 243–244
problems, 936
table text, 326–328, 326–328
with UCS, 604–609, 605–608
Origin UCS tool, 599, 606
origins
    boxes, 563, 563
dimensions, 338, 338
drawings, 116, 116
hatch patterns, 208–210
line groups, 816, 816
ordinate dimensions, 373–374
plotters, 249, 249, 263–264, 264
UCS, 373–374, 599, 599,
    606–607
Ortho button, 79
Ortho mode, 80
orthogonal projections, 726
orthogonal views,
    581–582, 582,
    727–728, 728
Orthographic UCSs tab, 598
Osnap marker, 38, 38
Osnap menu, 45–46, 45
Osnap Tracking and overrides, 38
3D drawings, 568
aligning objects, 97–102,
    98–102
base points, 45–46, 45–46
center of circles, 385
color, 910
construction lines, 185–191
dimensions, 363
disabling, 43
with inserting, 183–184, 183
lines, 176–179
midpoints, 93
options, 95–96
in Paper Space, 462
Polar Tracking, 80
polylines, 616, 616
QuickCalc calculator, 441–442
text alignment, 301–302, 301
UCS, 601
Osnap Tracking vector, 180
Other field for sheet sets, 880
Other Predefined tab, 209, 209,
    215, 215
Otrack button, 100, 177
Outer hatch pattern style, 218
Output Data To External File
option, 402
output devices
    adding, 255–259, 255–258
    options for, 922
    plotters. See plotters
Output Size option, 682
Outside Borders option, 329–330
Over Dimension Line, With A
Leader option, 347, 948
Over Dimension Line, Without A
Leader option, 347
Overhanging Edges tool,
    589–590, 589
overlapping objects
display order, 221–224, 222
lines, 929, 930
raster images, 409–410
selecting, 450
viewports, 462
visibility of, 277
Overlay option, 230
overlays. See layers
Overline tool, 299
Override Current Style dialog
box, 942
Override option, 942
overscore characters, 311
Overview option, 852

P
p code, 311
P command, 172
packaging sheet sets, 892
Page Setup dialog box
    DWF format files, 831–832
    Paper Space, 455
    plot styles, 269–271, 269, 283
    plotters, 258, 922–923
Page Setup Manager dialog box
    associative dimensions, 471
    Paper Space, 455
    plot styles, 269, 283
    plotters, 258–260
    rendering 3D models, 694
page setups, storing,
    259–260, 259–260
paging memory, 931–932
Palette view, 837–838, 838
palettes. See toolbars
Pan and Zoom with Raster & OLE
option, 902
Pan command, 172
Pan Realtime command
    for interference, 624
    limitations, 201
    and regenerations, 201
Pan Realtime tool, 172, 240
panning, 171–172, 172
vs. Swivel, 584
with viewports, 457
pantone colors, 138–139, 138
Paper button, 457–458
paper size, 77, 243, 243, 927, 927, 930
Paper Size Name page, 549
Paper Space, 453
dimensions in, 471–473, 472, 729–730
layers, 462–464, 462–465
layout, 454–455
leaving, 459
line weights, 468–470, 468–469
linetypes, 470–471
vs. Model Space, 453–454, 454
multiple layouts, 465–466
odd-shaped viewports, 466–468, 466
plotting objects, 250
scaling, 461–462, 461
uses, 473
working with, 459–460, 460
Paperupdate system variable, 261
Paragraph dialog box, 304–305, 304
Paragraph tool, 299
parallel curves, 510, 511
parallel lines, 194
Parallel Osnap option, 96
Parallel Projection tool, 585, 586
parallel projections, 561
Parameter Sets tab, 505
Parameter tool, 479
parameters for dynamic blocks, 479–480, 480
for attribute extraction, 494–497, 495–497
editing, 484
for mirroring, 490–491, 490–491
options, 485
scale and stretch actions for, 486–490, 487–489
for selectable lists, 492–494, 492–494
sets for, 505
parentheses ()
in AutoLISP, 769–772
in calculator, 448
in Diesel, 805
for functions, 763–764
in tables, 331
Parquet tile pattern, 210
Partial Load dialog box, 933
Partial Open feature, 932, 932
parts, assembling, 197–200, 198–200
passwords
eTransmit, 821–822
files, 823–824
Paste command, 543
Paste From Clipboard tool, 555
Paste Special dialog box, 332, 551–552, 551, 554–555
Paste Value To Command Line QuickCalc tool, 436, 436, 438
pasting to command line, 443, 443
Path Type option, 230, 426
paths
external references, 228, 230, 426–427
support files, 897–898
patterns
gradients, 221
linetypes, 811. See also hatch patterns
pause function, 765
pausing
in AutoLISP programs, 765
for input in menus, 801–802, 801
PC2 files, 256
PC3 files, 261, 923
PCI Express (PCIe) graphics cards, 921
PCP files, 256
Pdmode system variable, 191, 529
Pe command, 511–512
contour lines, 514
converting objects to polylines, 514
Pedit command. See polylines
Pen Number option, 279
Pen Optimization Level option, 924–925
pen, configuring, 924–925
people, 679–682, 680–682
Percent option, 193
percent signs (%), 311
performance
configuring, 917–919, 917–918
display options for, 902
and memory, 931–933
periods (.), 35, 72
Perpendicular Osnap overrides, 96, 178
Perspective Projection tool, 585, 586
perspective views
changing to and from, 585
field of view in, 561
raster images in, 408
PHANTOM linetypes, 154
Photometric Lighting feature, 700–701, 700
Physical Pen Characteristics option, 925
pi function, 449
Pick Angle To Fill button, 168
Pick Center Point button, 167, 167
Pick Plot Style Table screen, 281
Pick Point button, 691, 691
pick points with hatch patterns, 210, 221
Pickadd system variable, 913
Pickauto system variable, 913
pickbox, 22, 913
Pickdrag system variable, 913
picking
objects. See selecting
points, 8, 31
Pickstyle system variable, 130, 913
Picture (Enhanced Metafile) OLE option, 554
Picture (Metafile) OLE option, 554
Pl command, 508
Place All Files In One Folder option, 822
Place Text Manually option, 949
Pick Text Manually option, 949
Planar Mapping tool, 673
Planar Object slice option, 716
planning drawings, 86–87, 86
Pll function, 445
Plot And Publish Details dialog box, 241, 241, 829
Plot And Publish tab, 249
options, 261–262
output devices, 256
plot style tables, 268
plot styles, 283
points

plot area
display as, 244
 extents for, 244
 limits, 244
 views as, 244
 windows as, 245
 Plot dialog box, 240–242,
 240, 245
 adjustments, 922–923
 DWF files, 831–832
 importing and saving
 settings, 928
 Visual Styles, 591
 Plot field for sheet sets, 880
 Plot In Background system
 variable, 250
 Plot Model Parameter (PMP) files,
 926–927
 Plot option, 149
 Plot Or Page Setup dialog box, 829
 plot preview background color,
 930–931
 Plot Stamp dialog box, 250–251,
 251, 262, 928–929, 928
 Plot Stamp Settings option, 892
 plot stamps, 928–929, 928–929
 Plot Style option, 149
 Plot Style Table Editor, 270–272,
 270–272
 Form View tab, 278–280
 General tab, 277–278
 line corner styles, 275–276
 multiple plot styles, 273–274
 solid areas, 277
 Table View tab, 278, 278,
 281–282, 282
 Plot Style Table Settings dialog
 box, 262, 268–269, 268, 281, 281
 Plot Style Table wizard, 281
 plot style tables, 267
 color, 267–270
 creating, 269–270, 269–270
 editing, 270–272, 271–272
 line corner styles, 275–276,
 275–276
 multiple, 273–275, 274–275
 named, 267–270
 solid areas, 276–277, 277
 visibility, 272–273, 272–273
 plot styles
 converting color to
 named, 286

plot styles
 information on, 540
 objects, 283–285, 284–285
 plotting with, 250
 Plot Styles dialog box, 270,
 273–274
 Plot Styles window, 283
 Plot To A Port option, 256
 Plot To File option, 256, 262
 Plot Upside-Down option, 243
 Plotstamp command, 928–929
 Plotter Configuration Editor,
 923–924
 calibration, 926–927, 926
 custom properties, 925
 Device And Document
 Settings tab, 923–924, 924
 DWF format files, 832, 832
 General tab, 923
 graphics, 925, 925
 initialization strings, 925
 media, 924
 merge control, 929, 930
 paper sizes, 927, 927, 930
 pens, 924–925
 Ports tab, 923
 raster files, 548–549, 548
 saving and importing, 928
 settings, 258–259, 258
 Plotter Device option, 242
 Plotter Name page, 256
 Plotter Named In Page Setups
 option, 828
 plotters. See also plotting
 background color
 plot preview, 930–931
 Windows metafile, 931
 configuring. See Plotter
 Configuration Editor
 filters, 930
 limits, 263, 263
 merge control, 929, 930
 origins, 263–264, 264
 plot stamps, 928–929, 928–929
 Plotters folder, 923
 Plotters window, 255–257,
 255, 261
 plotting
 batch and electronic, 264
 hiding objects, 250
 image files, 259
 with Layout tabs,
 251–255, 252
 with line weights, 247, 250
 offset in, 249, 249
 orientation, 243–244
 output devices, 255–259,
 255–258
 paper for, 77, 243, 243
 Paper Space objects, 250
 plot area in, 244–245
 with plot styles, 250
 previewing, 239–243, 240–242
 problems, 936
 scaling, 245–247
 shaded viewports, 248–249
 storing page setups, 259–260,
 259–260
 styles for. See plot style tables
 support paths, 899
 Plotting tab, 930
 Plt function, 445
 Plug-ins option, 853
 plus signs (+)
 in AutoLISP, 768, 771
 in calculator, 449
 in Diesel, 805, 808
 in menus, 802
 with tables, 331
 plus/minus signs, 311
 PMP (Plot Model Parameter) files,
 926–927
 point filters, 580, 581
 point lights, 668–669, 668
 Point Name dialog box, 691
 Point objects, 529
 Point/Path option, 692
 Point Selection cursor, 37, 38
 point selection mode, 32
 Point Style dialog box, 191–192,
 191, 529, 529
 Point tool, 29
 pointing devices, 905–906, 922
 Pointlight command, 668
 points
 AutoLISP, 772
 curve divisions, 528–530
 dimensions, 354–356, 355
 fractional distances between,
 443–445, 444
 indicating, 44–48, 46–47
 QuickCalc calculator for,
 441–442, 441, 446
relative, 446
selecting, 8, 11, 11–12, 31
spline curves, 526–528
style, 191, 529
with UCS, 605
Polar Angle Measurement
settings, 80
polar arrays, 166–168
Polar button, 31, 80, 185
polar coordinates, 34
Polar function, 784
polar north setting, 650–651
Polar Tracking feature, 31, 38, 38
angles, 79, 80
construction lines, 185–191
with inserting, 183, 183
lines, 180
with Object Snap Tracking,
78–79, 79
Polar Tracking tab, 79, 80, 185, 185
Polygon tool, 29
polygons
dimensioning, 365–367, 365–367
for viewports, 466–468, 466
Polyline tool, 29, 508, 514
polylines, 79
breaking, 516, 516
converting objects to, 514–515
copying, 510, 510
direction of, 516
divisions on, 528–530, 529
drawing, 507–509, 507–508
editing, 510–522
editing vertices on, 515–522
extruding
process, 573–578, 573–579
tapering in, 710–711, 710–711
joining, 511–512, 511
for meshes, 616
options, 509–510
revolving, 712–714, 712–714
with Sketch, 531
smoothing, 513–514, 513, 901
thickness, 512, 512
with UCS, 605
width, 520–522, 522
portrait orientation, 243–244
Ports page, 256, 256, 923
position of objects. See location
PostScript files, 550–551
pre-drawn symbols, 24–25, 25
pre-existing drawings. See
existing drawings
Preceding Dimension Text
option, 946
Precision list, 74
Precision option, 341, 949, 951, 953
predefined hatch patterns,
210–211, 211
predicates in If structures,
780–782
Prefix option, 950, 952
Prefix Sheet Titles With File Name
option, 862
preliminary sketches, 87–88
Presentation option for shaded
viewports, 248
Presets
attributes, 387, 387
rendering, 697–698, 697
Processing Background Job
message box, 829
Profiles tab, 914–915, 914
Project File Search Path
option, 422
Project option, 86
projects
office standards for,
848–853
paths for, 898
sheet sets for. See sheet sets
and Sheet Set Manager tool
Prolog option, 898
Prompt For Password
option, 822
Prompt for Pen Swapping
option, 924
Prompt To Select Nested Objects
option, 236
prompts
for attributes, 384, 386
Command window, 9
responding to, 38–42
Primary Units tab, 340–341, 340,
473, 949–950, 949
primitives, 703–705, 704
boolean operations with,
703–705, 705
extruding polylines for,
710–711, 710–711
joining, 706–708, 706–708
revolving polylines for,
712–714, 712–714
print spoolers, 898
printers and printing with Visual
Styles, 591. See also plotters;
plotting
background color
plot preview, 930–931
Windows metafile, 931
drawing limits, 75–78
filters, 930
merge control, 929, 930
options, 922–924
plot stamps, 928–929, 928–929
in rendering 3D models,
693–694, 693–694
priorities for coordinate data
entry, 908
Problems option, 853
procedural maps, 663–664, 663
Processing Background Job
classb, 829
Profiles tab, 914–915, 914
Project File Search Path
option, 422
Project option, 86
projects
office standards for,
848–853
paths for, 898
sheet sets for. See sheet sets
and Sheet Set Manager tool
Prolog option, 898
Prompt For Password
option, 822
Prompt for Pen Swapping
option, 924
Prompt To Select Nested Objects
option, 236
prompts
for attributes, 384, 386
Command window, 9
responding to, 38–42

properties and Properties palette
attributes, 385–386, 386, 392–393, 393
in customization, 796
dimension text, 357–358, 357
hatch patterns, 216, 216
layers, 140–143, 141
lights, 671
linetypes, 157
materials, 656–659, 656–659
objects, 67–68, 67
plot styles, 284–285, 284
plotters, 925
polylines, 510
Quick Select, 435
solids, 726
viewports, 253–254, 255, 255

Qdim command, 361
Qselect command, 434
Qtext, 317, 540
Quick Dimension tool, 361
Quick Exit option, 758
Quick Select button, 110
Quick Select dialog box, 434–435, 434
Quick Select filters, 434–435, 434
QuickCalc calculator, 435–436, 436
angles, 437–439, 437–439
in commands, 446–447
conversions, 440–441, 441
fractional distances, 443–445, 444
guidelines, 448–450
pasting to command line, 443
points, 441–442, 441, 446
storing values in, 447–448, 447–448
QuickCalc toolbar, 436, 436
quotation marks ("), 436–437, 436
in AutoLISP, 770–771
in macros, 765
in units, 76

R
R command, 94
r for radians, 75
r2d function, 449
Rad function, 445
radii
circles, 167
dimensions, 366–367, 367
Global Illumination, 697
Radius setting, 697
Radius tool, 366
RAM, 587
Raster And Shaded/Rendered Viewports setting, 925
Raster Clip option, 752
Raster File Export option, 259
raster images
brightness, contrast, and strength, 411–413, 411, 413
cutting, 410–411, 412
equalization, 548–549, 548
frames for, 413–415, 413
importing, 406–408, 406–408
quality, 413–415, 413
scaling, 409
transparency, 415
visibility, 409–410
Re-Order group option, 131
read-only files, 937
real numbers in AutoLISP, 769
Realistic visual style, 587, 587, 732, 732
Recent Commands command, 182, 543
Recent Files option, 835
Recover option, 545
recovering files, 545, 935
Recreate Boundaries option, 217
rectangular program, 775–778, 774
Rectangle tool, 29
Recycle bin, 932
Redefine Path option, 757
redefining blocks, 118–119, 397–398
REDIMODE dialog box, 757
Redo command, 33
Redo tool, 33, 299
Redraw tool, 37

redrawing vs. regeneration, 200–201
Refedit command, 398
Refedit toolbar, 233
Reference Edit dialog box, 232–237, 232, 236
reference files, 858
reference lines, 87–88, 185–191
Reference name option, 229
reference symbols, 122–123, 123
Reference toolbar, 420
Refine Data window, 401
Refine spline curve option, 527
Regen command, 37, 212
Regen option for vertices, 518
Regen When Switching Layouts option, 906
Regenauto command, 212
regeneration, controlling, 37, 200–201
and block substitution, 213
freezing layers for, 204–206
with layout tabs, 906
and Qtext, 317
saving views for, 201–204, 202–203
screen smoothness in, 201
in updating blocks, 212
Region.dwg drawing, 709
Region tool, 29, 708
regions, 219, 708–710, 709
relational operators in filters, 432
relative coordinates, 32–36, 35–36
Relative Path option, 230, 427
relative points, 446
release versions, exchanging files with, 549–550
Reload external reference option, 229
Rem function, 771
Remote Text object, 747
Remove option for attributes, 397
Remove Boundaries option, 217
Remove From Group option, 122
Remove From Group Filter option, 151
Remove From The List option, 684
Remove From Working SET tool, 235
Remove Sheets tool, 829, 829
Ren command, 296
Rename dialog box, 296
Rename & Renumber View dialog box, 872, 872
Rename options
groups, 131
layer settings, 430
profiles, 914
UCS, 599
Rename Sheet option, 830
renaming
groups of objects, 131
layer settings, 430
layouts, 830
profiles, 914
text styles, 296
UCS, 599–600
Render Again option, 684
Render control panel, 648, 682–684
Render Cropped Region tool, 685, 688
Render Environment option, 683
Render panel, 561, 561
Render Preset settings, 683
Render Presets Manager dialog box, 697–698, 697
Render tool, 648
Render window, 647–648, 648, 684
Rendered Object Smoothness setting, 651, 901
Rendered option, 248
rendering 3D models, 647–648, 648
animated walk-throughs, 690–692, 690
background, 659–661, 659–661
cameras, 684–689, 685–689
interior views, 695–697, 695–696
landscape and people, 679–682, 680–682
lights
distant, 651–654, 651–654
editing, 669–671, 669–670
natural light, 694
point, 668–669, 668
spotlights, 665–671, 666–670
materials, see materials options, 682–684, 682–683
presets, 697–698, 697
printing, 693–694, 693–694
sky simulation, 698–701, 698–700
texture maps, 671
bitmap size, 676–679, 677–679
buildings, 672–673, 672–673
materials to fit objects, 673–676, 674–675
Repeat function, 783
Replace All option, 316
Replace Block With Another Block tool, 748
Replace Existing Block option, 591, 729
replacing
blocks, 120–121, 213
text, 316–317, 316–317
reports for sheet sets, 891
Reset option for profiles, 915
resolution
displays, 901, 921
motion path animation, 692
Resolution setting, 692
resource drawings, 864, 864
Restore On Exit option, 745
restoring views, 203–204
Retain Boundaries option, 219
Retain Changes To Xref Layers option, 227, 232, 425, 904
Retain option, 109–110
Rev command, 713
Reverse option, 692
Revert To Original option, 758
Revolve tool, 713
revolving polylines, 712–714, 712–714
Rich Text Format files, 306
Right-Click Customization dialog box, 908, 908
right-clicking, 12
customizing, 908, 908
options, 40–42, 40, 42
Right Orthogonal views, 581, 582
right-side views, 726–729
Right text option, 309
Right tool, 299
Right UCS orientation, 598, 599
Romans fonts, 305, 306
Rot function, 445
Rotate command, 56, 359, 593
Rotate Faces tool, 720, 720
Rotate Grip tool, 643
Rotate Items As Copied option, 168
Rotate option for dimension text, 355
Rotate tool, 29
rotating
in 3D drawings, 566–568, 566–567, 593
in 3D space, 643, 643, 713–714, 714
in copying, 168
dimension text, 355, 358
dimensions, 359, 364, 364
with grips, 56, 56
with inserting, 114–115, 183
linetypes, 813
shapes, 755
surfaces, 720, 721
text, 308, 326
UCS, 600–601, 601, 607–608, 607–608
in unison, 501–504, 502–503
Rotation parameter, 501–502, 502
roughing in lines, 176–179, 177–179
Round Distances To option, 951
round function, 449
Round Off option, 950
rounding corners, 716–717, 716
row and column copies, 169–173, 169–173
rows in tables, 323–324, 323, 329
Rows menu
Insert Above command, 328
Insert Below command, 328
Rtext command, 747
Rtos function, 785–786
rubber banding, 31, 32
for distances, 35
for splines, 525, 526
Ruled option for Loft, 638, 638
ruler for indents and tabs, 302–305, 302–305
Ruler tool, 299
Running Osnap, 43, 89, 93, 96, 514, 908
S
safety options for files, 903
Sampling Limit setting, 684
Save option
layer settings, 430
rendering, 684
Save All Drawings option, 758
Save As option
Form View tab, 280
Open and Save tab, 902
Save As Options dialog box, 233
Save Block button, 478
Save Block Definition tool, 478
Save button
Batch Standards Checker, 852
Layer Translator, 854
Save Changes dialog box, 29
Save Changes to Layout option, 251
Save Copy option, 684
Save Data Extraction dialog box, 399, 399
Save Drawing As dialog box, exporting, 546–547
new drawings, 30
passwords, 823
standard files, 849
templates, 164
title blocks, 881
Save Layer Mappings dialog box, 854
Save List As dialog box, 828
Save Reference Edits button, 233, 235
Save Rendering To File option, 682, 682
Save Sheet List tool, 829, 829
Save UCS With View option, 609
Save UCS With Viewport option, 604
Save Workspace dialog box, 16, 16
Saveas Options dialog box, 546, 547
Saved Path option, 229
Savefilepath command, 22
saving
attribute data, 402–403, 402
AutoLISP programs, 786–787
automatic, 22
Batch Standards Checker files, 852
blocks, 120, 478
customizations, 803–804, 804
files, 22
filter criteria, 432
layer mappings, 854
layer settings, 427–430, 428–429
macros as files, 765, 765
options for, 902–904, 902
plot layout, 251
plotting options for, 928
problems, 936
QuickCalc calculations, 447–448, 447–448
rendering settings, 684
system information, 542–543
Text Window information, 543
UCS, 599–600, 609
views, 201–204, 202–203
workspaces, 16
Scale command, 57, 593
Scale Dimensions To Layout option, 345, 949
Scale drop-down list, 246–247, 247
Scale Factor option, 950
Scale option for Sweep, 628, 629–630
Scale panel, 372
Scale tool, 29, 409
Scale Uniformly option, 110
Scale X option, 842
Scale Y option, 842
Scale Z option, 842
Scaleolistedit command, 247
scaling, 75–78
annotations, 122–125, 123–125
blocks, 908
in DesignCenter, 842
dimensions, 948–949
in dynamic blocks, 486–490, 487–489
existing drawings, 405
with grips, 57
with inserting, 114–115, 388
in Layout tabs, 253–255, 254
linetypes, 156–157, 156–157
in Paper Space, 461–462, 461, 470–471
in plotting, 245–247
custom scales, 246–247
for line weights, 247
predefined scales, 244–245
raster images, 409
text, 294–295
viewports, 760–761
Scaling For Height option, 953
scanning raster images, 406
Scientific measurement system, 74
screens. See also displays
cleaning up, 37
plotting, 244
regenerating. See regeneration, controlling
smoothness on, 201
virtual, 200–201
scroll bars, 173, 900
SE Isometric Wireframe option, 672
Search dialog box, 840–841, 840
Search For The Word(s) option, 841
Search Now feature, 841
search paths for external references, 426–427
Search Subfolders feature, 841
searching
for drawing contents, 840–842, 840
for files, 544–545, 545
in help system, 62–64, 62–63
for layers, 147–148
for text, 316–317, 316–317
Second angle option, 370
Second arrowhead option, 945
Second Set option, 624
Section Boundary option, 734–735
Section Plane option, 734
section planes, 732–737, 733–736
Section Settings dialog box, 737, 737
Section Volume option, 734, 736
sectionplane command, 732
security for files
digital signatures, 824–827, 825–827
passwords, 823–824
Security Options dialog box
digital signatures, 824, 825, 827
passwords, 823–824
Securityoptions command, 824
Segments In A Polyline Curve option, 901
Select A File dialog box, 315
Select A Sheet Set To Use As An Example option, 867
Select Block dialog box, 886, 886
Select Block option, 592
Select Color dialog box
gradients, 220, 220
layers, 137–138, 137–138, 142, 145, 150
materials, 655, 655
objects, 159
plot styles, 275, 275
self-illuminated materials,
662–663, 663
surfaces, 724
Select Dimension tool, 375
Select Drawing dialog box,
175, 865
Select Drawing File dialog box, 115, 212, 853
Select Drawings dialog box, 828
Select DWF File dialog box, 828
Select File dialog box, 16–17, 164, 167, 204, 306, 545, 545, 933
Select Initial View dialog box, 204
Select Layers menu, Add command, 151
Select Layout As Sheet Template dialog box, 865
Select Linetype dialog box, 155, 155
Select Object button, 321
Select Object option
blocks, 109
exporting dxf files, 547
Select Objects screen, 400
Select Options button, 316
Select Path button, 690, 690
Select Place In Document dialog box, 835
Select Plot Style dialog box, 284–285, 284
Select Properties screen, 401, 401
Select Reference dialog box, 230
Select Reference File dialog box, 226, 420
Select Render Preset list, 683
Select Shape File dialog box, 755
Select Standards File dialog box, 850
Select Template dialog box, 5, 269
3D workspace, 559
metrics, 954
multiple documents, 23
named plot styles, 280, 280
new drawings, 29
Selectable group options, 131–132
selectable lists, 492–494, 492–494
Selected Grip Color option, 913
selecting
in AutoLISP, 778–780
Express Tools for, 756
layers, 139, 147–148
linetypes, 155, 155
menu commands, 9–11
objects, 22, 42–44, 43–44
base points for, 44–48, 46–47
for blocks, 108–109
close and overlapping, 450
filters, 430–433, 431
noun/verb method, 48, 50, 52, 913, 916
options, 48–50, 912–914
problems, 935
Quick Select, 434–435, 434
point filters for, 580, 581
points, 8, 11, 11–12, 31
previous selections, 46
right-click menu options, 40–42, 40, 42
selection cycling feature, 450
Selection Cycling tool, 450
Selection Filters tool, 432
Selection tab
noun/verb method, 916
options, 912–914, 912
selection windows, 8
self-illuminated materials,
662–663, 662–663
semicolons (;), 800
Send E-Mail With Transmittal option, 822
Separate tool, 725
separating divided solids, 725–726, 725
Set Current button, 139, 139
Set Current options
dimensions, 941
profiles, 914
text styles, 295
Set Default Plotter to ‘None’ option, 822
Set Mtext Height command, 822
Set Mtext Width command, 822
Set Size Relative to Screen option, 191, 529
Setq function, 768
settings, importing, 174–176, 175–176
Settings dialog box attributes, 397, 398
Layer Translator, 855
Settings tab external references, 236, 236
UCS, 462
Setvar command, 541
Shade Plot menu
Hidden command, 693
Rendered command, 693
Shade Plot options, 248, 731
Shaded Viewport Options dialog box, 694
shaded viewports, 248–249, 694
Shadeplot option, 695
shading gradient, 219–221
shadow properties for lights, 671
shape definitions, 754
shapes
Express Tools for, 754–756
grids for editing, 53
linetypes, 814, 814
multiple, 497–501, 498–501
purging, 194
pushing and pulling from solids, 569–570, 569–571
solids, 621–622
with UCS, 606
viewport, 466–468, 466
ShareSetPlaceholder option, 882
sharing drawings, See exchanging data; exporting; importing
Sheet Creation Template option, 865
Sheet List tab, 861–862, 865, 873
Sheet Set Details page, 859–860, 859, 863, 867
Sheet Set Example page, 867
Sheet Set Manager, 4
Sheet Set Properties dialog box, 865, 886, 886
Sheet Set Publish Options option, 892
Sheet Set Template Location setting, 865
sheet sets and Sheet Set Manager tool, 857
archiving, 889–891, 890–891
batch plotting and publishing, 891–892, 891
callout blocks with, 872–874, 873, 887–889, 887–888
closing, 875–876
creating, 858–866, 859–861, 863–864, 866, 870
customizing, 876–889, 877–879, 883–888
eTransmit for, 892
from existing sheet sets, 867–868
for file management, 858
import options in, 862
for new sheets, 866
previewing and opening drawings in, 862–863, 863
for project files, 892–893
properties for, 863, 878–880, 879
resource drawings in, 864, 864
sheet templates in, 865–866
title blocks with, 876–882, 877–879
view labels with, 883–885, 883–885
views for, 868–872, 869, 871–872
Sheets tab, 890–891, 890
SheetSet field, 880
SheetSet option, 882
SheetView option, 882
Shell tool, 722, 722
shells, turning solids into, 722–723, 723
Shift key
for base points, 45
for selecting objects, 913
Shortcut Keys dialog box, 803, 803
shortcut menus, 40–42, 40, 42, 829–830
Shortcut Menus in Drawing Areas option, 907
shortcuts, 15–16
keyboard, 10, 87
Command Alias Editor for, 751–752, 751
settings, 907
troubleshooting, 936
on menus, 802–803, 803
Shortcuts group, 795
Show option for Flatshot, 592
Show Cut-Away Geometry option, 734, 734
Show Labels For Dynamic UCS option, 911
Show Proxy Information Dialog Box option, 905
Show Shortcut Keys In ToolTips option, 901
Show Text Boundary Frame Only option, 902
Show ToolTips option, 901
Show URLs option, 758
Show Z Axis In Crosshairs option, 911
Show Z Field For Pointer Input option, 911
.show extension, 814–815, 814
signatures, 824–827, 825–827
Sigvalidate command, 825
simplex.shx font, 315
sin function
AutoLISP, 772
calculator, 449
single-line text objects
adding, 307–308
aligning, 309–310, 309–310
editing, 308
special characters with, 311–312
single quotes (’), 541
Single selection option, 50
Single Viewport tool, 653, 653
size
arrowheads, 945
AutoSnap markers, 92
bitmap images, 676–679, 677–679
Command window, 7
crosshair cursor, 38
external references, 229
grips, 53, 913
hatch patterns, 214
output media, 924
paper, 77, 243, 243, 549, 927, 927, 930
pickbox, 913
raster images, 408
table cells, 326–327
Size option for external references, 229
Size Is option in searches, 842
Sketch command, 531
sketches, preliminary, 87–88
skewing dimension lines, 368, 368
sky, simulating, 698–701, 698–700
Sky Background And Illumination tool, 698, 698
slashes (/)
in AutoLISP, 771, 781, 787
in calculator, 449
in Diesel, 805, 808
for options, 39
with tables, 331
Slice command, 715
Slice tool, 715
slicing solids with surfaces, 634–635, 634–635
Smooth Fit option, 638, 638
smoothness
arcs and circles, 651, 901
polylines, 513–514, 513
on screen, 201
Snap And Grid tab, 103, 103
Snap button, 104
snap mode, 104. See also Osnap Tracking and overrides with editing, 82–83
information on, 540
with Polar Tracking, 78–79, 79
Snap X Spacing option, 104
Snap Y Spacing option, 104
Snapunit system variable, 104
solid fills for Tool Palettes, 846–847
Solid hatch pattern, 210
Solidedit command, 725
solids and solid modeling, 703–705
for 2D drawings, 708–710, 709
for 3D drawings, 562–563, 562
chamfering, 718, 718
command line, 725
complex, 710–714, 710–714
converting surfaces to, 621
copying faces and edges on, 724
deleting surfaces, 720
editing, 571–572, 572–573
extruding surfaces, 721–722, 723
filling, 522
interference between, 622–625, 623–625
joining primitives for, 706–708, 706–708
moving surfaces, 719, 719
from objects with thickness, 578–579, 578–579, 602
offsetting surfaces, 720, 720
plot style tables for, 276–277, 277
properties, 726
pushing and pulling to shapes, 569–570, 569–571
with regions, 708–710, 709
rotating surfaces, 720, 721
rounding corners on, 716–717, 716
separating divided solids, 725–726, 725
shaping, 621–622
slicing with surfaces, 634–635, 634–635
splitting, 715–716, 715
stereolithography in, 738
surface features, 724–725
tapering surfaces, 721, 722
turning solids into shells, 722–723, 723
with UCS, 605
visualizing, 731–737, 732–738
sorting
layer names, 147
layers in layer lists, 139
Source And Size option, 924
source for output media, 924
Southeast Isometric button, 665, 665
Southeast Isometric view, 581, 582
Southwest Isometric view, 581, 582
Sp command, 311–312
space, information on, 540
space planning and hatch patterns, 221–224, 222
Space property, 158
spaces
in attribute values, 395
in units, 75
spacing
dimension lines, 945
hatch patterns, 207
Spatial indexes, 933
Spatial option for demand loading, 233
Spe command, 515, 527
special characters, 300–302, 300–301, 311–312
Specified Origin option, 210
Specify Location Folder dialog box, 821
Specify On-Screen option, 112, 114, 198, 230, 420
Specify Plot Offset Relative To setting, 262
spell checking, 312–314, 312–314
spheres, 703, 704
spherical coordinate format, 614, 615
spiral forms, 630–632, 630–632
Spl command, 515, 525
splash screen, 4
Splframe system variable, 524
spline curves, 81
control points, 526–528
converting polylines to, 514–515
creating, 522–524, 523–524
drawing, 525–526, 525–526
editing, 526–528
length, 192
for polylines, 512
Spline tool, 29, 515
Splinedit command, 527
splitting solids, 715–716, 715
spoolers, 898
spotlights
creating, 665–667, 666–668
drawing, 669–671, 669–670
spreadsheet files
importing, 553–554, 553
inserting, 551–555, 551–554
sqrt function in calculator, 449
Sqrt function in AutoLISP, 772
square brackets ([])
in calculator, 448
for linetypes, 813–814
Ssget function, 778–780
St command, 291
Stack Fraction tool, 299
Standard cursor, 37, 38
Standard dimension style, 339, 340
standard hatch patterns, 815
standard linetypes, 810–811, 810
standard symbols, 38, 39
Standard text style, 290
Standard toolbar, 748–750
standard windows, 51–52, 52
standards
dimensions, 338
office, 848–853
Standards command, 850–851, 850
Standards option, 853
Standards tab, 852, 852
Start Check button, 852
Start Cross Section option, 638
Start Magnitude setting, 640
Start Table settings, 335
Start With option, 941
Statistics tab, 544
status bar, 6, 7, 8
displaying, 47, 47
for keyboard equivalents, 10
Status command, 539–540, 539
Status option for external references, 229
status screen, 539
.stb files, 268, 286
stereolithography, 738
.stl extension, 738
Stop Check button, 852
Stop feature in searches, 841
Store As Default Origin option, 211
Store Links Index in Drawing File option, 906
Store Sheet Set Data File option, 867
storing
information, 543–544, 544
page setups, 259–260, 259–260
straightening vertices, 518–519, 519–520
strcat function, 771, 784
strength of raster images, 411–413, 411, 413
Stretch command, 53–55, 593
Stretch tool, 29, 510
stretching
actions for, 480–482, 481–482
blocks, 114
dimensioned objects, 359, 359
for dynamic block parameters, 486–490, 487–489
lines, 53–55, 54
polylines, 510
viewport, 460
strings in AutoLISP, 769, 771, 784
strings of dimensions, 361–362, 362
styles
angles, 74–75
alternate units, 346, 346
arrows, 342–345, 343–345
current, 347
editing, 347. See also Modify Dimension Style dialog box
primary units, 340–341, 340
text, 341–342, 341–342
multileaders, 370–372, 371
names, 236–237
plotting. See plot style tables
points, 191, 529
purging, 194
tables, 334–336, 334–335
text. See text styles
units, 72–73
Styles option for dimensions, 941
styxus, 922
Su command, 707
subjects, storing, 544
subobjects, 572
substituting
blocks, 213
fonts, 314–315, 315, 551
Substr function, 784
substrings in AutoLISP, 784
Subtract function in Diesel, 808
Subtract tool, 707
subtraction
area calculations, 536–538, 536, 538
AutoLISP, 771
calculator, 449
Presspull, 570
primitives, 704, 705, 707–708, 708–709
in tables, 331
Suffix option, 950, 952
Suggestions box with spelling checker, 312
Sum function in tables, 332
Summary tab, 544
sums of angles calculations, 437–439, 437–439
Sun And Sky Simulation feature, 698–701, 698–700
Sun status tab, 648, 648, 667
SuperHatch dialog box, 749–750, 749
SuperHatch tool, 748–750
support files, 897
Support Knowledge Base option, 64
Suppress Arrows If They Don’t Fit Inside Extension Lines option, 948
suppressing dimension and extension lines, 945
Surface slice option, 716
surfaces, 562, 562, 613
adding features to, 724–725
contours on, 901
converting to solids, 621
creating, 632–634, 633
curved, 616–620, 617–620
deleting, 720
drawing on, 568–569, 569
extruding, 721–722, 723
laying out forms for, 613–614, 613–614
Loft for, 637–640, 637–639
moving, 719, 719
offsetting, 720, 720
polylines for, 615–616, 616
rotating, 720, 721
slicing solids with, 634–635, 634–635
tapering, 721, 722
volumes of cuts, 635–637, 635–637
Surfaces tessellation option, 919
.sv$ extension, 22, 935
swap files, 540, 931–932
sweep command, 626, 632
swap files, 540, .sv$ extension, 22, 935
.sv$ extension, 22, 935
Sweep tool, 300
Symbol dialog box, 375, 375
Sweep tool, 626–627, 626–629
spiral forms, 630–632, 630–632
tubes, 625–627, 626
Swivel tool, 584, 584
Symbol dialog box, 375, 375
Symbol tool, 300
symbols
annotation scale, 122–125, 123–125
creating, 107–109, 108
downloading, 844
existing drawings as, 115–118, 116–117
external references with, 122
inserting, 111–115, 112–113
libraries for, 107
replacing, 120–121
saving, 120
standard, 38, 39
unblocking, 118–119, 119
Symbols And Arrows tab, 342–345, 343
Symbols fonts, 305, 306
Sync option for attributes, 397
Synchronize Viewports tool, 759–760
System Printer option, 255
System Printer Spool Alerts, 261
System tab, 905, 905
3D performance, 905
dbConnect, 906
general options, 906
layout tabs, 906
Live Enabler, 906–907
pointing devices, 905–906, 922
system variables
overview, 939–940, 939–940
status of, 541–542

T
Table Style dialog box, 334, 334
Table Style screen, 403, 403
Table tool, 29
Table View tab, 271
named plot styles, 281–282, 282
Plot Style Table Editor dialog box, 278, 278
tables, 323
attribute data for, 403–404, 403–404
creating, 323–324, 323–324
exporting, 333
formulas, 330–332, 330–331
graphics for, 333, 333
importing and exporting, 332–333, 332
importing spreadsheets as, 553–554, 553
line work for, 328–330, 328–329
styles, 334–336, 334–335
text in, 324–325, 324–326
text orientation and location in, 326–328, 326–328
table menu area, 915–916, 915
tabs for text, 302–305, 302–305
tags for blocks, 384–386, 394
tang function, 449
tangent direction
spline curves, 527
vertices, 520, 521
Tangent Osnap option, 96
Taper Faces tool, 721, 721
tapering
extrusions, 710–711, 710–711
surfaces, 721, 722
Target option for cameras, 687
TC text option, 309
Template Description dialog box, 164–165, 164, 881
Template folder, 164
templates, 163–164
creating, 164–165, 164
location, 899
metric, 954
sheet, 865–866
for title blocks, 880–882
using, 29, 165
temporary files
extensions, 903
location, 899
tessellation settings, 918–919
testing templates, 881–882
text, 289–290
adding, 292–294, 292–293
aligning, 301–302, 301
associating with drawing properties, 319–323, 320–322
for attributes, 384
AutoLISP, 771
backgrounds for, 746
Diesel, 809
dimensions, 338, 338
appending data to, 353–354
height, 341–342, 341
location and orientation, 342, 342
moving, 357–358, 357
options, 946–947
rotating, 358
styles, 357–358
Express Tools for, 746–747
finding and replacing, 316–317, 316–317
fonts, 314–315, 315, 551
height, 296–298, 298, 384
indents and tabs, 302–305, 302–305
in linetypes, 814
linked, 747
manipulating, 317
mirroring, 310–311, 311
oblique angle, 296, 296
options, 902
problems, 936
Qtext, 317, 540
rotating, 308, 326
scaling, 294–295
special characters, 300–302, 300–301
spell checking, 312–314, 312–314
styles for. See text styles for tables. See text objects
with UCS, 606
width, 296, 296
text boxes for macros, 801–802, 802
Text Color option, 946
Text editors, location of, 898
text files, importing, 306–307
Text Formatting dialog box, 321, 324–327, 809
Text Formatting toolbar, 293
dimensions, 354, 354
displaying, 298, 298
indents and tabs, 302–305
styles, 296
tools, 298–300, 299
Text Height option, 946
text objects, 307–308
aligning, 309–310
editing, 308
special characters with, 311–312
Text option
dimension text, 948
OLE, 555
Text Options group for attributes, 384
Text Options panel, 372
Text Options tab, 392, 392
Text Rotation option, 326
Text Style dialog box
creating styles, 291, 291
options, 295–296
text styles
creating, 290–291, 290–291
dimensions, 946
effects, 296, 296
names, 291, 295–296
options, 295–296
Text tab, 341–342, 341, 946–947
Text To Display setting, 836
Text Window, 66, 66, 159, 543
Textfill system variable, 307
texture. See hatch patterns
texture maps
paths, 900
for rendering 3D models, 671
bitmap size, 676–679, 677–679
for buildings, 672–673, 672–673
materials to fit objects, 673–676, 674–675
Thaw layer option, 149
Thicken command, 621
Thicken Surface tool, 621, 621
thickness
in 3D drawings, 578–579, 578–579, 602
information on, 540
lines. See line weights
polylines, 512, 512
Thumbnail Preview Settings option, 903
tick marks, 954–955
tiled viewports, 609–610
time, information for, 541, 541
Time command, 541
Time screen, 541, 541
title blocks with sheet sets,
876–882, 877–879
titles, storing, 544
TL text option, 309
Tm command, 459
Tol command, 375
tolerance for spline curves, 527
Tolerance option, 527
tolerance symbols, 374–376, 375–376
Tolerance tool, 375
Tolerances tab, 952–953, 952
Tool Palettes
hatch patterns and solid fills for, 846–847
managing, 847–848
for pre-drawn symbols,
24–25, 25
tools, 844–846, 846
Tool Properties dialog box, 846, 846
tool tips appearance, 910
toolbars, 6–7, 7, 14–15
buttons, 797–798, 797–798
creating, 796–797
for Express Tools, 744, 744
flyouts with, 14, 14
tools for
adding, 791–793, 792–793
creating, 797–798,
797–798
macros in, 800, 800
Tools menu
Attribute Extraction command, 496
CAD Standards menu
Check command, 851
Configure command, 850
Layer Translator command, 853
Data Extraction command, 399
Drafting Settings command, 88, 95, 104
Draw Order menu
Bring Above Object command, 410
Bring To Front command, 223, 410
Bring Under Object command, 410
Send To Back command, 224, 410, 450
Find command, 545
Inquiry menu
Area command, 534–535, 537
Distance command, 74
ID Point command, 533
List command, 66, 158
Region/Mass Properties command, 726
Region menu, Mass properties command, 636
Set Variables command, 541
Status command, 539–540
Time command, 541
Load Applications command, 761, 763, 786
Move UCS command, 606–607
Named UCS command, 462, 598–599, 617
New UCS menu
3 Point command, 617
Face command, 569, 620
Object command, 604
Origin command, 373, 599, 606
View command, 609
World command, 569
Z command, 607
Z Axis Vector command, 608
Options command. See Options dialog box
Palettes command, 13, 560, 595
Quick Select command, 434
Security Options command, 823
Spelling command, 312
Tablet command, 915
Update View To Plan When UCS Is Changed option, 462, 604
updating
associative dimensions, 473
blocks, 212–213, 213
external references, 424–425, 424–425
OLE links, 552–553
Upper Value option, 953
Uppercase tool, 299
upside down text, 296
Uscfollow system variable, 462
Use A Template option, 269
Use As Default Output Device option, 261
Use Assigned Pen # option, 279
Use Big Font option, 296
Use Color Dependent Plot Styles option, 262, 268
Use Current Origin option, 210, 219
use first point as displacement option, 46
Use For option, 942
Use Large Buttons For Toolbars option, 901
Use Last Successful Plot Settings option, 261
Use Named Plot Styles option, 262, 268
Use OLE Application When Plotting OLE objects option, 262
Use Organized Folder Structure option, 822
Use Overall Scale Of option, 345, 948
Use Paper Space Units For Scaling option, 471
Use Radius setting, 697
Use Relative Path For Hyperlink option, 834
Use Shift to Add To Selection option, 913
Use Source Hatch Origin option, 219
Use The Plot Device Paper Size option, 261
User Arrow dialog box, 955
user coordinate system (UCS). See UCS (user coordinate system)
User Defined Fields dialog box, 928, 929
user-defined hatch patterns, 207
User Defined options for hatch patterns, 207
user-defined page setups, 260
user input
AutoLISP, 775–778, 778
in menus, 801–802, 801
user interface, customizing, 791–794, 792–794
User Preferences tab, 907–909, 907
associative dimensions, 471, 729
line weights, 273
scale lists, 247
V
Valid Digital ID Not Available dialog box, 824, 824
Validate Digital Signature dialog box, 826, 826
Value option for Quick Select, 435
Variable Definition dialog box, 448, 448
variables
AutoLISP, 768, 769
data types, 769–770
text, 771, 780
QuickCalc, 447–448, 447–448
Vec function, 445
Vec1 function, 445
vector files, 408, 550–551
Vector Graphics setting, 925
Ver Xline option, 190
Verify option, 387
verifying attributes, 387
versions, exchanging files between, 549–550
vertical bars (|), 426
Vertical Cell Margin option, 327
vertical dimensions, 342, 349–350, 349, 947
vertical lines, 31
Vertical Position option, 953
vertical Xlines, 190
vertices
breaking, 516, 516
editing, 512, 515–522
inserting, 517, 517
moving, 517–518, 518
validating, 518–519, 519–520
tangent direction, 520, 521
width, 520–522, 522
View Archive Report dialog box, 891
view labels with sheet sets, 883–885, 883–885
View Lock command, 462
View Manager dialog box, 393
backgrounds, 659, 659, 661
camera name, 687
eexisting view, 202, 202
title blocks, 868–870
View menu, 10, 10
3D Views menu, 582
Plan View command, 19
SW Isometric command, 574, 597, 613
Concepts command, 63
Hide command, 708
Motion Path Animation command, 690
Named Views command, 202, 462, 609
Orbit command, 583
Redraw command, 37, 685
Viewports menu
1 Viewport command, 612
Named Viewports command, 609–610
New Viewports command, 456
Object command, 466
Visual Styles menu
Realistic command, 587
Wireframe command, 587
Zoom menu
All command, 24, 30, 76, 198, 200, 202
Extents command, 204, 321, 457
Previous command, 20, 86
Window command, 19, 82, 457
View option
cameras, 687
plot area, 244
View Of This Drawing option, 836
View Report tool, 853
View Selections hatch pattern option, 217
View slice option, 716
View tab for hidden folders, 919
View Tune Log button, 917
View UCS tool, 609
viewing
3D drawings, 581–585
DWF files, 830, 830
linetypes, 810–811, 810
viewports, 453–454
3D drawings, 609–612, 609–612
accessing, 457–458, 458
active, 460
aligning, 759–761, 760
creating, 455–456, 456–457
erasing, 459, 460
features, 201
layers for, 462–464, 462–465
in Layout tabs, 252–253, 252
line weights, 468–470, 468–469
merging, 760–761
multiple layouts, 465–466
odd-shaped, 466–468, 466
scaling, 253–255, 254, 461–462, 461, 760–761
shaded, 248–249
Visual Styles, 730–731, 730–731
working with, 459–460, 460
Viewports dialog box, 456, 456, 609–610, 609
Viewports toolbar, 456
Viewres command, 156, 201
views
 cameras for, 684–687, 685–687
multiple, 201
in opening files, 204
perspective. See perspective views
plotting, 244
restoring, 203–204
saving, 201–204, 202–203
saving UCS with, 609
for sheet sets, 868–872, 869, 871–872
standard, 726–729, 727–728
Views tool, 838–839
virtual memory, 540, 931–932
Virtual Pen # option, 279
virtual screens, 200–201
visibility
 attributes, 394–395, 395
block states, 498–501
layers, 145–147, 146, 149
overlapping objects, 277
plot style tables, 272–273, 272–273
raster images, 409–410
Visibility parameter, 492, 498–499, 499
Visibility States dialog box, 499, 499
Visretain system variable, 227, 423
visual effects, 585
Visual Style option, 625
Visual Style panel, 561, 561, 586–590, 586–590
Visual Styles feature, 560–561
motion path animation, 692
printing with, 591
sketch presentations, 695
viewports, 730–731, 730–731
Visual Styles Manager tool, 587, 587
visualizing solids, 731–737, 732–738
volumes of cuts, 635–637, 635–637
VP Freeze option, 463
Vports command, 468
W
w2u function, 445
Walk And Fly Settings dialog box, 912, 912
walk-throughs, 561, 690–692, 690
Walk tool, 584–585, 584
Wblock command, 120–121, 418, 431
WCS (World Coordinate System), 8, 566, 596
Web. See World Wide Web (WWW) sites
wedges, 703, 704
weight of lines. See line weights
When Previewing Show Camera Preview option, 692
While keyword in AutoLISP, 783
width
 columns in layer lists, 139
polylines, 509, 512, 512
table cells, 326–327
text, 296, 296
vertices, 520–522, 522
Width Factor tool, 300
wildcard characters in layer filters, 153
Window menu, Tile Vertically command, 23
Window options
plot area, 245
in selecting, 49
Window Polygon option, 49
Window Polygons, 49
windows
crossing, 51–52, 358–359, 359
plotting, 245
for selecting objects, 43–44, 44, 48–52, 51–52
zooming, 18–22, 19–21, 82
Windows MetaFile (WMF) files, 550
Wipeout object, 746
Wireframe option for shaded viewports, 248
Wireframe views, 250, 575
WMF (Windows MetaFile) files, 550
Wmfbgnd system variable, 930
wood, procedural maps for, 662–663, 662
work areas, 71
drawing limits for, 75–78
scale factors for, 77–78
units for, 72–74
workgroups, external references for, 122, 228, 423
Working Support File Search Path, 897
workpoints. See Grips feature
worksheets
importing, 553–554, 553
inserting, 551–555, 551–554
workspace, 6–7, 7
3D Modeling, 559–562, 560–562
selecting, 5, 5
Workspace screen, 4
Workspace Settings dialog box, 790, 790
Workspace Settings tool, 790
workspaces, 16, 16, 789–791, 790
Workspaces toolbar, 559, 560, 790, 790
World Coordinate System (WCS), 8, 566, 596
World UCS tool, 618
World Wide Web (WWW) sites
DWF files in, 833
Express Tools for, 758
file search paths, 900
hyperlinks, 833–836, 834, 836
Write Block dialog box, 120–121, 121, 431

X
X axis, 8, 566
X Axis Rotate option, 607
X coordinates, point filters for, 580
X input box setting, 249
X-ray mode, 732, 732
X scale factor for symbols, 114
Xa command, 420
Xb command, 423
Xbind dialog box, 228, 425–426, 425–426
XBind tool, 425, 425
Xclip command, 230
Xdatum option, 374
XL command, 187
Xlines, 187–191, 188
Xr command, 225, 421
Xref files. See external references
XY/YZ/ZX slice option, 716

Y
Y axis, 8, 566
Y Axis Rotate option, 607
Y coordinates, point filters for, 580
Y input box setting, 249
Y scale factor for symbols, 114
Ydatum option, 374

Z
Z axis in Dynamic UCS, 566
Z Axis Rotate option, 607
Z Axis Vector tool, 608, 608
Z coordinates, point filters for, 580
Z scale factor for symbols, 114
Zaxis option with slicing, 716
Zero Suppression option, 950, 953
zerop operator, 782
zeros
in dimension text, 341, 950, 953
leading, 35
Zigzag linetype, 154
Zoom All tool, 76
Zoom command, 457–458
Zoom Realtime tool, 21, 82
in copying, 172
for interference, 624
limitations, 201
in plot preview, 240
Zoom To Pair option, 624
Zoom Window flyout, 29
Zoom Window tool, 82, 82
zooming, 18–22, 19–21
drawings, 76
for extents, 204
with hatch patterns, 221
in Layout tabs, 252, 252
vs. panning, 171
to previous view, 86
in viewports, 457–458
for windows, 82